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Preface

This instruction manual serves as a guide for using this software. It is intended to instruct
first-time users on how to properly use the software, and to serve as a reference for
experienced users.

Before using the software, read this instruction manual carefully, and make sure you fully
understand its contents. This manual should be easily accessible to the operator at all times
during software operation. When not using the software, keep this manual stored in a safe
place. Should this instruction manual be lost, order a replacement from your local JASCO
distributor.



Servicing

Contact your local JASCO distributor for instrument servicing. In addition, contact your JASCO
distributor before moving the instrument to another location. Consumable parts should be
ordered according to part number from your local JASCO distributor. If a part number is
unknown, give your JASCO distributor the model name and serial number of your instrument.

Do not return contaminated products or parts that may constitute a health hazard to
JASCO employees.

Notices

(1) JASCO shall not be held liable, either directly or indirectly, for any consequential damage
incurred as a result of product use.

(2) Prohibitions on the use of JASCO software

o Copying software for purposes other than backup

e Transfer or licensing of the right to use software to a third party

o Disclosure of confidential information regarding software

¢ Modification of software

o Use of software on multiple workstations, network terminals, or by other methods
(not applicable under a network licensing agreement concluded with JASCO)

(3) The contents of this manual are subject to change without notice for product
improvement.

(4) This manual is considered complete and accurate at publication.
(5) This manual does not guarantee the validity of any patent rights or other rights.

(6) If a JASCO software program has failed causing an error or improper operation, this may
be caused by a conflict from another program operating on the PC. In this case, take
corrective action by uninstalling the conflicting product(s).

(7) Windows is a registered trademark of Microsoft Corporation in the United States and
other countries. In general, company names and product names are trademarks or
registered trademarks of the respective companies. However, the ™ and ® marks are not
used in all cases in this manual.

(8) JASCO and the JASCO logo are registered trademarks of JASCO Corporation in Japan
and other countries.

© JASCO Corporation, 2014. All rights reserved. Printed in JAPAN.



Limited Warranty

Products sold by JASCO, unless otherwise specified, are warranted for a period of one year
from the date of shipment to be free of defects in materials and workmanship. If any defects in
the product are found during this warranty period, JASCO will repair or replace the defective
part(s) or product free of charge.

THIS WARRANTY DOES NOT APPLY TO DEFECTS RESULTING FROM THE
FOLLOWING:

IMPROPER OR INADEQUATE INSTALLATION

IMPROPER OR INADEQUATE OPERATION, MAINTENANCE, ADJUSTMENT OR
CALIBRATION

UNAUTHORIZED MODIFICATION OR MISUSE

USE OF CONSUMABLE PARTS NOT SUPPLIED BY AN AUTHORIZED JASCO
DISTRIBUTOR

CORROSION DUE TO THE USE OF IMPROPER SOLVENTS, SAMPLES, OR DUE
TO SURROUNDING GASES

ACCIDENTS BEYOND JASCOQO'S CONTROL, INCLUDING NATURAL DISASTERS
CONSUMABLES AND PARTS OF WHICH WARRANTY PERIOD IS SPECIFIED
OTHERWISE.

THE WARRANTY FOR ALL PARTS SUPPLIED AND REPAIRS PROVIDED UNDER THIS
WARRANTY EXPIRES ON THE WARRANTY EXPIRATION DATE OF THE ORIGINAL
PRODUCT. FOR INQUIRIES CONCERNING REPAIR SERVICE, CONTACT YOUR JASCO
DISTRIBUTOR AFTER CONFIRMING THE MODEL NAME AND SERIAL NUMBER OF
YOUR INSTRUMENT.

JASCO Corporation

2967-5, Ishikawa-machi, Hachioji-shi
Tokyo 192-8537,

JAPAN



Notation Used

The following notational conventions are used throughout this manual:

General Notation

Notation

Meaning

[Measurement] menu
[Parameters...] command

Names of menus, commands, and text boxes are enclosed in
square brackets ‘[ ]’, followed by a description indicating
whether the function is a menu, command, text box, etc.
Shortcut keys used to select menus or commands are
underlined.

<OK>, <Cancel>

Names of buttons are enclosed in angular brackets ‘< >*.

Keyboard Operations

Notation

Meaning

The key is enclosed in a square and shown in boldface.

Al I

Keys that are to be pressed in succession are separated by
commas. In the example shown on the left, the [Alf key is to
be pressed and released, followed by the E key.

Shift| +

Keys that are pressed simultaneously are separated by a
"plus” sign. In the example shown on the left, press the
key while holding down the Shifﬂ key.

Mouse Operations

Notation

Meaning

Point Move the mouse pointer to the specified item.

Click Quickly press and release the mouse button.
Double-click Click the mouse button twice in rapid succession.

Drag Point to an item, click and hold down the mouse button.

Move the mouse with the button held down, and release
the button when the pointer is in the desired position.
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1. Introduction

1.1 How to Use This Manual

This manual is for the JASCO J-1000 series CD spectrometer measurement program that runs
on Microsoft Windows. The J-1000 series CD spectrometer measurement program consists of
[Spectra Manager CFR-Compliant Program], which conforms to FDA regulation 21 CFR Part
11 concerning electronic records and electronic signatures, and [Spectra Manager
v.2-Compliant Program], which does not conform to these standards. This instruction manual
refers to [Spectra Manager CFR-Compliant Program] and [Spectra Manager v.2-Compliant
Program] as [CFR Version Program] and [Non-CFR Version Program], respectively.

This chapter describes the structure and use of this manual. The manual consists of 7 chapters
including this one. An explanation of each chapter is given below. For this manual, Microsoft
Windows is referred to as Windows and a personal computer as a PC.

1. Introduction

This chapter describes how to use this manual and gives an overview of each program and
menu. Read this chapter first.

2. Starting and Exiting Programs and the [Spectra Manager] Program Reference

This chapter describes detailed procedures ranging from turning on/off the CD spectrometer
and PC to starting/exiting the programs. Refer to Chapter 3 for details about program
operations. In addition, this chapter provides the [Spectra Manager] program reference.

3. Accessory Registration Reference

This chapter describes how to register accessories used with the CD spectrometer.

4. Introduction to the [Spectra Measurement] Program

This chapter describes the [Spectra Measurement/Analysis] programs with examples of basic
procedures. Users unfamiliar with Windows or first-time users of the CD spectrometer should
follow the procedures described in this chapter for a general overview of how to operate the
program.

5. Introduction to the [Time Course Measurement/Analysis] Programs
This chapter describes the [Time Course Measurement/Analysis] programs with examples of
basic procedures.

6 to 9. Measurement Program References

These chapters describe common toolbar and menu commands for the [Spectra
Measurement], [Time Course Measurement] and [Data Monitor] programs, in addition to the
parameters used in these programs. Read the relevant chapters as required.

6. Toolbar and menu reference.

7. [Spectra Measurement] program reference

8. [Time Course Measurement] program reference



9. [Data Monitor] program reference

10. Appendix

This chapter provides useful suggestions for specifying parameters for CD measurements.



1.2 FDA 21CFR Part 11

FDA 21 CFR Part 11 is a set of regulations regarding digital archiving of data and data records
for GLP, GCP, and GMP procedures. These regulations cover a number of areas, including: 1)
access control and electronic signature requirements for data recorded by any
computer-controlled analytical system in which the results are digitally archived; 2) the
provision of security functions that can only be accessed by authorized personnel to ensure the
security and integrity of data; and 3) a data auditing mechanism with the automatic creation of
an Audit Trail to maintain a record of any creation, modification or deletion of instrument data.

1.3 Features of [Spectra Manager] Compatible with FDA
21CFR Part 11

JASCO Spectra Manager™ is an integrated software package that acts as a common platform
for the range of JASCO analytical instruments, including UV/Vis, near-infrared, infrared,
fluorescence, Raman, polarimetry, and circular dichroism spectrometers. The Spectra
Manager™ software provides functionality ranging from analytical instrument control and
spectral data processing to sophisticated and specialized data analysis programs. JASCO
Spectra Manager™ CFR provides security and auditing functionality that ensures the security,
integrity and confidentiality of electronic records by enforcing the use of electronic signatures
and other security measures as described in the regulations outlined in 21 CFR Part 11.

JASCO Spectra Manager™ CFR consists of three core modules: Administrative Tools and
Security Manager modules; intrinsic components of the Spectra Manager™ CFR software; and
a database, which is an external component to the Spectra Manager™ CFR software. In
addition, there are two broad classes of add-on modules: instrument drivers, which are
spectrometer-specific; and spectral analysis modules, which provide a range of sophisticated
analytical and data processing tools. These add-on modules integrate seamlessly with the
three core components of the Spectra Manager system to provide compliance with 21 CFR
Part 11 regulations over the entire range of JASCO products. Figure 1.1 illustrates the system

organization.
Instrument

Security

Manager

Spectra

Manager™ CFR
Administrative
Tools

Figure 1.1 Structure of Spectra Manager™ CFR

All of the security management functions of JASCO Spectra Manager™ CFR are accessed
through the Administrative Tools interface. The Security Manager components of the system
are not directly accessible by a user, and thus the operation of these modules is not described.



For secure management of data and data records, JASCO Spectra Manager™ CFR has two
levels of security: system-level security and workgroup-level security.

When a user is registered in JASCO Spectra Manager™ CFR, the user must be assigned to
one of four possible System Access Levels: “Administrators”, “Power Users”, “Users”, or
“Limited Users”. The level of control that a user has over the management functions of the
software system is determined by the System Access Level assigned to that user. Table 1.1
outlines the different rights assigned to the different types of users depending on their System

Access Levels.

Table 1.1 Rights of each System Access Level

Administrators |Power Users| Users |Limited Users
Display/modify system policy OK
Add/delete users OK

Modify user properties (incl. System OK
Access Level)

Add a workgroup OK

Delete a workgroup Workgroup Managers only
Modify workgroup users Workgroup Managers only
Add/delete instruments OK

Modify instrument configuration OK

Add/delete programs OK

Display log management OK OK

Workgroups correspond to actual groupings of users within the organization and may
represent divisions such as projects, departments, or research groups. Each workgroup has a
set of users, instruments, accessories, and analysis programs associated with it; only users
registered with a specific workgroup may access the instruments and programs of that
workgroup. Within a workgroup, users are granted access as either a “Manager”, “Analyst”, or
“Operator”, with authorities to modify instrument and analysis settings and use resources
within the workgroup determined by the Workgroup User Rights granted. Selectable
Workgroup User Rights vary depending on the system access level of the user. Table 1.2
outlines the relationship between the System Access Levels and Workgroup User Rights.

Table 1.2 Qualified access levels by Workgroup User Rights

Administrators | Power Users Users Limited Users
Managers OK OK
Analysts OK OK OK
Operators OK OK OK OK

By employing a two-level security model, global security authorization is independent of
instrument, accessory, and application authorization, resulting in a highly flexible security
system. Table 1.3 outlines the different rights assigned to the different types of users
depending on their Workgroup User Rights.



Table 1.3 Rights of each Workgroup User Rights

Managers | Analysts | Operators

Register/unregister workgroup users OK

Change Workgroup user authorities OK

Register/unregister instruments for the workgroup OK

Register/unregister programs for the workgroup OK

Use a registered instrument OK OK OK
Use a registered instrument application OK OK OK
Modify measurement parameters OK OK

Use a registered analysis program OK OK OK
Modify analysis parameters OK OK
Electronically sign data OK OK OK

Figure 1.2 shows the typical operational flow of the JASCO Spectra Manager™ CFR. First, a
user is created (registered) and their System Access Level is assigned using Administrative
Tools. A Workgroup is created (registered), and individual users and analytical instruments are
assigned to the Workgroup. Detailed access to instrument control and analysis programs can
be set at the User and Workgroup levels. Access control levels as required by FDA 21 CFR
Part 11 regulations are determined by the Administrative Tools settings.

Routine analyses can then be conducted by the operator using the measurement/analysis
programs in JASCO Spectra Manager™ CFR. Since all levels of access are managed by
Security Manager, individual users are only able to execute procedures that are allowed by
their assigned access level. Access control ranges from declaring measurement parameters to
conducting measurements and performing data analysis.

Analytical data obtained using any of the procedures described above can be saved as an
electronic record with an electronic signature.

Administrative Tools I

 Llser reqistration
- Waorkgroup registration

- Access rights setting

Spectra Manager™ CFR I
= Measurement

= Analysis
= Save with electronic signature

= Review and Approval signature

Figure 1.2 Operational flow



1.4 Overview of [Spectra Manager]

[Spectra Manager] refers to the entire suite of measurement/analysis and administrative
programs for JASCO CD spectrometers.

Specifically, [Spectra Manager] is a software program that communicates with the CD
Spectrometer to start various measurement and analysis programs. Common programs that
are used include programs for performing measurements using the CD Spectrometer, the
[Validation] program for checking the performance of the CD spectrometer, and the [Spectra
Analysis], [JASCO Canvas] and [Administrative Tools] programs.

Spectra Measurement Controls the CD spectrometer and measures samples.

Validation Checks the performance of the CD spectrometer.

Spectra Analysis Displays, processes, and prints the data obtained by [Spectra
Measurement].

JASCO Canvas Customizes the format of spectral data for printing.

Administrative Tools  Controls the administration of the CD spectrometer and
measurement/analysis programs including the assignment of user
authority.

This manual mainly explains how to use several of the measurement programs. Refer to
[Hardware Manual] for details about how to use the CD spectrometer. Refer to the individual
instruction manuals for details about the [Validation], [Interval Scan Measurement], [Spectra
Analysis], [Interval Data Analysis], and [JASCO Canvas] programs.



2,

2.1

Starting and Exiting Programs and the [Spectra

Manager] Program Reference
Starting the program

211 Turning on the CD Spectrometer

(1)

3)

(4)

Confirm that the standard detector is installed on the J-1000 series CD spectrometer. If
other detector has been installed, replace it with the standard detector. Refer to the
hardware manual “Model J-1100/1500 CD Spectrometer” or “Model J-1700 CD
Spectrometer” for instructions on removing or installing the detector.

Supply nitrogen gas at a flow rate of 3 L/min. It takes about five minutes to displace the air
from the interior of the optical system at this flow rate. If measurements are carried out at
wavelengths shorter than 190 nm, the light will be absorbed by residual traces of oxygen.
In this case, increase the nitrogen flow rate to prevent a decrease in the light intensity
incident on the sample.

Nitrogen flow rate for different measurement wavelength ranges:

Up to 190 nm 2 L/min

Up to 185 nm 2 to 15 L/min

Up to 180 nm 15 to 20 L/min
Less than 180 nm More than 20 L/min

When using the 450 W Xe lamp, feed cooling water to the light source at a flow rate of
about 2 L/min.

Turn on the "Power" switch at the left side of the CD spectrometer.

WARNING!: Running the xenon (Xe) lamp in air will generate ozone gas, which is

harmful to humans. Always supply nitrogen gas at a flow rate of 3
L/min for a few minutes before turning on the light source.

Note 1: Ozone gas absorbs light at wavelengths of 200 to 300 nm and 600 to 700 nm.

This makes it difficult to perform measurements in these wavelength regions
and can also damage optical parts due to corrosion. Always supply nitrogen
gas before turning on the light source.

Note 2: Never use helium gas. It will permeate into the photomultiplier tube, reducing

the vacuum level and the functionality of the tube.

Note 3: If a PC-controlled nitrogen gas flow meter (an optional accessory) is installed,

all that is necessary to do is to simply open the main valve of the gas cylinder.
Nitrogen will start flowing when the spectrometer is started. The flow rate can
be controlled via the measurement program.

Note 4: Step (3) is not necessary with the 150 W Xe lamp, which is cooled with air.
Note 5: Just turning ON the "Power" switch does not result in the light source being

turned on. The light source will be turned on automatically when the
measurement program is started.




21.2 Starting the PC and Windows and Registering a J-1000
Series CD spectrometer

Turn on the PC and monitor to start Windows. When a J-1000 series CD spectrometer is

connected for the first time, registration of the CD spectrometer is required in [Spectra

Manager].

Note: The operations described in this section can be performed only by
Administrators.

Start [Administrative Tools], right-click [Instrument] and select [Register Instrument...] from the
shortcut menu to display the window in Fig. 2.2.

-
Q Administrative Tools

Operation  View Help

Q Administrative Tools Tnstrumen...
----- #, System Policy
W 1 cument
.[EA Analysis Pre Register [nstrument...
g User Control
Log Management
- System Information
Workgroup
Figure 2.1 [Administrative Tools] window

(1) Select the check box for the JASCO J-1000 series control driver and click the <Next>
button to display the dialog box in Fig. 2.3.

rF -
Select Instrument Diriver @

Select an instrument driver.

Crriver Mame Cre=cription

[ J-1000 Cantral Driver JASC0 J-1000 zeries control driver

“Back || Mext> | | Cancel |

Figure 2.2 [Select Instrument Driver] dialog box




(2) Enter the CD spectrometer name, model name and serial number and then click the
<Finish> button to register the CD spectrometer. The model name and serial number are
inscribed on the name plate on the rear panel of the CD spectrometer.

i -
Instrument Properties @

Enter an instrument name, model name, and serial number.
Instrument name:
Model name: [J-j_5|:||:| -
Serial Mao:
| <Back || Finish | | Cancal |

Figure 2.3 [Instrument Properties] dialog box
The CD spectrometer is registered and the name is displayed in the right pane of the
[Administrative Tools] window.

=) Administrative Tools = | B |t
Operation View Help

=

=) Administrative Tools Inztrument .. Model Mame  Serial Mo, Condition

..... #, System Policy S50 1500 I 1600 ADDD Sleep |
- Instrument

{8 Analysis Program
w-#G User Control

-] Log Management

----- System Information
Waorkgroup

Ready

Figure 2.4 [Administrative Tools] window



Note: After registering the CD spectrometer, exit the program and perform the
following operations after logging on again.

(3) Restart [Spectra Manager] and start [Administrative Tools]. Right-click the registered CD
spectrometer name and select [Properties...] to display the dialog box in Fig. 2.5. First,
check that [Model name], [Display name], [Serial number], and [Driver version] are
displayed in the [General] tab.

Properties - 1-1500-4/A000461638 [

General |Enmpositinn I Phatometric mode Deleclorsl Meazurar * | "

todel name: J-1500

Diizplay name: J-1500-4
Serial number: ADOD4ETE38
Dirivver wergian: 1.00.00 [Build 36]

ROk wversian: 0.0r.00

J-1500
Peltier ternperature power unit

Instrument uge time 3021 hours

[ Ok H Cancel J

Figure 2.5 [General] tab in [Properties] dialog box
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(4) Click the [Composition] tab to set parameters for the nitrogen gas flow meter and the light

source.
g B'e a
Properties - 3-1700/A0002 @38 | oroperties - 1-1500/A0001 =5
General| Composition | Photometric mode | Detectors | Measuren] ¢ | * General | Composition | Phatometiic mode | Detectors | Measuren| <[ »
Set the compositon of the instrurmnent, Set the compositon of the instrument.
Mitrogen-gas Mitrogen-gas
Preflow time: 3 i (0 - 60 min) Freflow tme: 5 iy (0 - 60 min)
Select flowmeter: [.&utomatic [PC contral) '] Select flowmeter | Manual without senzar v]
[ Set up automatically when staring measurement. Set up autornatically when starting measurement. Details...
[ Betum to standard flow after measurement end. Beturn to standard flaw after measurement end.
[ Turm off lamp after gas fow emor. Turn off Jamp after gas flaw errar.
5 5
Larmp Lamp
[T1ET o an wenon lamp when program starts.: Turn on xenon lamp when program starts.
[ Tum on halogen lamp when program starts. [ Use an extemnal light source (Halogen lamp).
140 signal output... 1400 signal output...
[ Ok ] [ Cancel ] [ Ok ] [ Cancel ]

Figure 2.6 [Composition] tab in [Properties] dialog box J-1700 (left), J-1500 (right)

Nitrogen-gas

[Preflow time]

Specifies the nitrogen gas preflow time before the light
source is turned on.

[Select flowmeter]

Selects the nitrogen gas flow meter.

[Manual without sensor]: Select this when using a manual
flow meter with no sensor.

[Manual with sensor]: Select this when using a manual flow
meter with a sensor.

[Automatic (PC control)]: Select this when using a
PC-controlled automatic flow meter.

[Set up automatically at
measurement]

Specifies the nitrogen gas flow rate for the idling or
measurement state. The flow rate is automatically
controlled. This function is only available when the
[Automatic (PC control)] flow meter is selected.
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[ Details [—"E_E-r

Set the nitragen gas flow.

Standard flow

Flow rate; a L/mirn

Flaws during measurements

Flaw rate [Lémin]  Meas. delay [min]

T 190 nm 1) i 1]
To 185 nm [2]; 10 ]
To 180 nm [3); 20 10
To 175 nm [4]: a0 15
Below 175 nm (51 100 a0
[ook | | Canizel | | Diefault |

Figure 2.7 [Details] dialog box

[Return to standard flow after
a measurement end]

Specifies that the flow rate is automatically returned to the
standard flow rate after measurement. This function is only
available when the [Automatic (PC control)] flow meter is
selected.

[Turn off lamp after gas flow
error]

Specifies that the lamp is automatically turned off after a
gas flow error has occurred. This function is only available
when the [Automatic (PC control)] or [Manual with sensor]
flow meter is selected.

[Lamp off timer]

Specifies the time before the light source is automatically
turned off after a nitrogen gas flow error has occurred. This
function is only available when the [Automatic (PC control)]
or [Manual with sensor] flow meter is selected.

Lamp

[Turn on xenon lamp when

program starts]

Specifies that the Xe lamp is automatically turned on when
the measurement program is started.

[Turn on halogen lamp when

program stars]

Specifies that the W1 lamp is automatically turned on when
the measurement program is started. (only for J-1700)

[Use an external light source
(Halogen lamp)]

Specifies that the external halogen lamp is used. (only for
J-1500)

<|/O signal output...>

Specifies that the drain and external start signals from the
CD spectrometer are sent to the accessory attached to the
I/O ports. Select the desired check boxes. When the
accessory is made by JASCO, these settings are

12



unnecessary.

I/O Signal Output

[ Enable drain signal
@ 101 16
/02 12
Positive @) Megative
1000

[] Enable extemal start signal

EoOK [ Caneel ]

Figure 2.8 [I/O Signal Output] dialog box

(5) Click the [Photometric mode] tab to register the photometric mode.

The electric signals except other than CD signals can be detected using the J-1000 series
CD spectrometer. The photometric modes selected in this dialog box are displayed in the
measurement program. For J-1100, the available photometric modes are limited.

[ Properties - 1-1700/A0002 Iﬁw f Properties - J-1100/A0004 @1
Phatomnetric mode | Detectors | Measuren| * | * General | Composition | Phatometic mode | Cell Units | External s * [ *
Activate additional photometric modes by selecting them from the Activate additional photometic modes by selecting them from the
fallowing list. The selected modes appear in the channel drop-down list fallowing list. The selected modes appear in the chantel drop-dawn list
in the parameter setting window. in the parameter setting window.
Ch [ Intensity Co Intensity
LD [T 0% doubleftbs) LD 1% doubleftbs)
[ ORD-M [T double%T) QR0 1% double%:T)
[C10RD-E [CTHTIFL) ORD-E HTIFL)
HT [T DCiFL) HT DCIFL)
] [1pH pH Calibratian... oC [pH pH Calibratian...
[CFDCD [ External 1 FOCD [] Extemal 1
[T FOILD [ Euternal 2 FOLD [C]External 2
[] &nizatropy Test signal Anizatrapy Test signal
I DFF [Caw DFP [ 2w
[C]DRED [ a2w DRCD [ a2w
[C|DRLD [T] aw(FL) DRLD awlFL]
CO/DC [ a2wiFL) CO/DC a2wlFL)
[C1FDCD/DC FOCD/DC
Abs Abs
L% single(&bs) U singlelsbs)
L% zingle(%T) U zingle(%T)
[ (]9 ] [ Cancel ] [ ak ] [ Cancel ]

Figure 2.9 [Photometric mode] tab in [Properties] dialog box J-1500/1700 (left), J-1100 (right)
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CD

Measures the circular dichroism signal

LD Measures the linear dichroism signal

ORD-M Measures the optical rotational dispersion signal. The
ORD-M accessory is required. (Not available for J-1100)

ORD-E Measures the optical rotational dispersion signal. The
ORD-E accessory is required. (Not available for J-1100)

HT Measures the high-tension (HT) voltage applied to the
CD photomultiplier tube in the transmission
configuration.

DC Measures the direct current (DC) voltage applied to
the CD photomultiplier tube in the transmission
configuration.

FDCD Measures the fluorescence detected circular dichroism
signal. The FDCD accessory is required. (Not available for
J-1100)

AF=F-F,

Fi: Fluorescence intensity excited by left circularly polarized
light

F.: Fluorescence intensity excited by right circularly
polarized light

FDLD Measures the fluorescence detected linear dichroism
signal. The FDCD accessory is required. (Not available for
J-1100)

AF=F,-F,
F,. Fluorescence intensity excited by horizontally linear
polarized light
F | : Fluorescence intensity excited by vertically linear
polarized light

Anisotropy Measures the fluorescence anisotropy signal. (Not
available for J-1100).

D.F.P. Measures the degree of fluorescence polarization signal.
(Not available for J-1100).

DRCD Measures the circular dichroism signal using detector for
fluorescence configuration

DRLD Measures the linear dichroism signal using detector for
fluorescence configuration

CD/DC Measures the CD and DC signals and displays the CD
signal divided by the DC signal.

FDCD/DC Measures the FDCD and DC signals and displays the
FDCD signal divided by the DC signal. (Not available for
J-1100).

Abs. Measures the absorbance spectrum. The absorbance

signal is obtained by conversion of the HT signal. Select

14



this when the HT voltage for the photomultiplier tube in the
transmission configuration is set to Auto.

UV single (Abs.)

Measures the absorbance spectrum. The absorbance
signal is obtained by conversion of the DC signal. Select
this when the HT voltage for the photomultiplier tube in the
transmission configuration is set to Manual.

UV single (%T)

Measures the transmittance (%T) spectrum. The %T signal
is obtained by conversion of the DC signal. Select this when
the HT voltage for the photomultiplier tube in the
transmission configuration is set to Manual.

Intensity

Measures the fluorescence intensity. Select this when the
HT voltage for the photomultiplier tube in the fluorescence
configuration (90 degrees with respect to the measurement
beam direction) is set to Auto.

(Not available for J-1100)

UV double (Abs.)

Measures the absorbance spectrum using a UV double
beam attachment. (Not available for J-1100)

UV double (%T)

Measures the transmittance spectrum using a UV double
beam attachment. (Not available for J-1100)

HT(FL)

Measures the applied voltage (HTV) to the photomultiplier
tube in the fluorescence configuration (90 degrees with
respect to the measurement beam direction). (Not available
for J-1100)

DC(FL)

Measures the direct current (DC) voltage to the
photomultiplier tube in the fluorescence configuration (90
degrees with respect to the measurement beam direction).
(Not available for J-1100)

pH

Measures the direct current signal from the pH meter. The
pH meter is required.

External 1

Measures the signal from external signal input 1 ("EXT 1"
terminal on the rear panel of the amplifier).

External 2

Measures the signal from external signal input 2 ("EXT 2"
terminal on the rear panel of the amplifier).

Test signal

This is mainly used for checking the instrument.

aw

Measures the 50 kHz signal from the detector in the
transmission configuration for the measurement beam.
(Used for JASCO service engineers.)

a2w

Measures the 100 kHz signal from the detector in the
transmission configuration for the measurement beam.
(Used for JASCO service engineers.)

aw(FL)

Measures the 50 kHz signal from the detector in the
fluorescence configuration (90 degrees with respect to the
measurement beam direction) for the measurement beam.
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(Used for JASCO service engineers. Not available for
J-1100)

a2w(FL) Measures the 100 kHz signal from the detector in the

fluorescence configuration (90 degrees with respect to the
measurement beam direction) for the measurement beam.
Used for JASCO service engineers. (Not available for
J-1100)

The example of combination in accessories and photometric mode

FDCD unit: FDCD, FDLD, DC(FL), FL Detector (manual)
Integrating sphere: DRCD, DRLD, HT(FL)

Emission monochromator: Intensity, FL Detector (manual)

Stopped flow: CD/DC, DC, CD Detector (manual)
ORDM-520 ORD-M, HT

ORDE-521 ORD-E, HT

(6)

Detector for fluorescence
>y configuration

L5

L&:AT 8H g,
E ¥ e . .
bl I L M Detector for transmission
M configuration
oM
" 1 ]
LR ] sy ._ .33 B D
Emy l l

Figure 2.10 Configuration of detectors

Click the [Detectors], [Measurement Units], [Cell Units] and [External Accessories] tabs to
register detectors, measurement units, cell units, and external accessories, respectively.
Refer to Chapter 4 for details about registering accessories.

Click the [Adjustments] tab to perform CD spectrometer adjustments.
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Properties - 1-1700/A0002 [ | [ Properties - -1 100,@\0004‘—.‘@

| Cell Urits I Eternal Accessories | Adiustment I Adjustment [J-1700 4 [+ | Cell Urits | EHtemaIAccessories| Adjustment | Seryicing i
Diaghastic Diaghostic
Diagnoge the ingtument, Diaghose the instrument.
Initialization Initialization

Initialize the instrument. Initialize: the: instrument.

[ Maintnt. || waveengh. |[ s, | | Mainlnit. || wavelength. || Sit. |
Lamp Lamp

e lamp 236 howrs @. He lamp 0.0 hours

W lamp 3.7 hours Hg lamp 0.0 hours

Ha larmp 2.4 hours = Display warning message when the Xenon lamp has

beet wzed for mare than 1000 hr.
Dizplay warning mezzage when the lamps have been uged for
rmare thah 1000 kr.

CD zcale
e lamp Wl lamp
@ Calibrate CD scale.
CD scale
@ Calibrate CD scale.
[ ak. ] [ Cancel ] [ QK ] [ Cancel ]

Figure 2.11 [Adjustments] tab in [Properties] dialog box J-1500/1700 (left), J-1100 (right)

Diagnostic
<Diagnostics...> Confirms whether the CD spectrometer is functioning
correctly.
Initialization
<Main Unit> Initializes the instrument settings.
<Wavelength> Initializes the wavelength settings.
<Slit> Initializes the slit width settings.
Lamp
[Xe lamp] Displays the number of hours the xenon lamp has been

used. When the xenon lamp is exchanged, click the
<Exchange> button to reset the number of hours used to 0.

[WI lamp] Displays the number of hours the halogen lamp has been
used. When the halogen lamp is exchanged, click the
<Exchange> button to reset the number of hours used to 0.
(only for J-1700)

[Hg lamp] Displays the number of hours the mercury lamp has been
used. When the mercury lamp is exchanged, click the
<Exchange> button to reset the number of hours used to 0.
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[Display warning message
when the lamps have been
used for more than 1000 hr]

Displays a warning message when the xenon and/or
halogen lamp have been used for more than 1000 hours
(see Fig. 2.12). Halogen lamp can be selected only for
J-1700.

S5C)

J-1500-4/A000461638

The xenon lamp haz been uzed for more than 1000
hours. Replace the lamp.

Do ot shiowe thiz meszage again.

b

Figure 2.12 Warning message for xenon lamp usage time

Note:  The lifetime of the xenon lamp is
approximately 1000 hours. When it has
been used for more than 1000 hours, the

decrease in intensity of the light source will

effect measurements.
CD scale Calibrates the scale for CD signal. Used for users.
Record log Records a log of J-1000. When error occurs, send a log to

JASCO service engineers.

||§||i".3-1

i Log Information [

Log  [J1700_20140402_112147.lag -|

[ControlCore] -
11123300=Connect

1112391 6=Crd| D [0)/5 tart

11128190=Crad| D [5)/5 tart
11128206=Crd|D[1]/5tart
11128222=CrdID[1)/E nd/ReturnCade|0x0)
11128237 =Crd|D[3)/5tart
11128253=Connect

11132581 2=Crad D[5)/S tart
11132839=CrndID[35)/Start
11132964=Crad|D[35)/End/R eturnCode(0=0]
[Uzb]

11123932=G etDevicelnfal]

111 25882=G ethoceszonl niol0]
11126897 =G etboceszonlnfol1]

11125891 3=Gethcceszonlnfal2]

| &l Delete |

Figure 2.13 [Log Information] dialog box

m

Dekte | | 0K
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Click the <Diagnostics...> button to display the [Diagnostics] dialog box. This function
confirms whether the CD spectrometer is functioning correctly.

F )
Diagnostics ﬁ

[tem Statusz
L {Initialize

a_J AJD converzion Pazz
a_J Arnplifier Pazz
a_J HT circuit Pazz
@ PEM circuit Paszz
a_J HT wolt control Pazz
a_J W avelenagth drive Pazz
a_J Slit drive Pazz
a_J e lamp Pazz
a_J Wi ater flowrneter Pazz
a_J Lamp temperature Pazz
a_J Shutter Pazz
@ Leaked water Pags
a_J Mitrogen-gas flowmeter Pazz
@ EEFROMAZC Pass
The spectropolarimeter haz been initialized normally.

Cloze

Figure 2.14 [Diagnostics] dialog box

If an error message is displayed in the message area in Fig 2.13, contact your local
JASCO distributor.
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(8) Click the [Adjustment (J-1700)] tab to perform CD spectrometer adjustments. (Only
J-1700)

.

Properties - J-1700/A0002 =

|E:<terna|.-’-\c:cessories Adjustment | Adiustment [J-1700) | Serviging 4 | *
Changeover wavelengths

@ Adjust the changeower wavelengths,

- Sefting...

Wi avelength calibration

'ITL' Ferfarm the wavelength calibration. Execute. ..

k5 optics adjuztrent
@ Uy Aie (I MIR
Adjust the optical path of the M5, Adjust...

Auto detectar changer

@ Pr-539 / 200001

Set current detector pozition. Setting...

l Ok ][ Cancel ]

Figure 2.15 [Diagnostics] dialog box

Changeover wavelengths

<Setting...> Sets the changeover wavelengths for light source, grating
and detectors.
[ Changeover Wavelength Settings &Jw
Light source / Grating :
163 nm 2500 tim
500 -
. > »le > e
| + >
Detectar 1 Detectar 2 :
300 . 1600 -
[ ok ] [ Cancel ]

Figure 2.16 [Changeover Wavelength Settings] dialog box
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Wavelength calibration

<Execute...> Calibrates the wavelength for grating in NIR region.

[Z] wavelength Calibration

1600.0 nm = 0055 v

5

0 L | L | L L
1400 1450 1500 15850 1600
Wavelength [nm]

Make sure the sample compartment is emptly, then press [Execute]

Cancel

Figure 2.17 [Wavelength Calibration] dialog box

M5 optics adjustment

<Adjust> Adjusts the M5 mirror in UV/Vis or NIR region.
[9] M5 Optics Adjustment ;J‘

5461 |nm 250 v

1000

800~

600

HT [V]

400~

200~

0 L 1 L L | L
-2000 -1000 0 1000 2000
Point

Make sure the sample compartment is empty, then press [Execute].

Figure 2.18 [M5 Optics Adjustment] dialog box

Auto detector changer

<Setting> Sets current detector positions.

Auto Detector Changer I&

Detectar position: | Ph4-539 -

P-539
IM5SE-54

Figure 2.19 [Auto Detector Changer] dialog box
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(9) Click the [Servicing] tab to calibrate CD spectrometer conditions such as the detector

sensitivity. If calibration

is required, contact your local JASCO distributor.

Properties - J-1700/A0002

Ha lamp
W

Detector synchronization

Turn ondoff the mercury lamp.

% Calibrate detector phase shift.

Data offzet/scale

Calibrate CD scale.

| adjustment | Adjustment (J1700) | Servicing |

' |
[ | Properties - 1-1100/A0004 [
e | Cell Units | External Accessories Adiuslmentl Servicing Al
Hg lamp
@ Turn ondoff the mercury lamp.
Detectar synchranization
% Calibrate detector phase shift.

Data offzet/scale

Calibrate CD scale.

[HT/DC offset...||CDLLD offset... | [HT/DC scale... | [ CDULD scale...|

\HT/DC offset...||CDALD offset...| [HT/DC scdle...| | CDALD sele...|

Lock-in amplifier mode

Dietectar gain

@ Calibrate detector gain.

Lock-in amplifier mode

tMode...

Detector gain

@ Calibrate detector gain.

[ oo J[ . ORDE... Arisatropy... [ o, |[ Lo
HT-OD comversion HT-0D conversion
% Coarrect HT-0D conwversion equation. |-!.TD Carrect HT-0D conversion equation.
Maintenance Maintenance
Do maintenance an equipment. Do maintenance on equipment.
[ oK ] [ Cancel ] i (o[ S| ’ Cancel ]

Figure 2.20 [Calibrations] tab in [Properties] dialog box

Hg lamp

Turns the mercury lamp on or off.

Detector synchronization

Calibrates the phase shift of the CD and FL detectors. Used for
JASCO service engineers.

Data offset/scale

Calibrates the offset and scale of Main unit (J-1000). Used for
JASCO service engineers.

Lock-in amplifier mode

Selects the lock-in amplifier mode. Used for JASCO service
engineers.

Detector gain

Calibrates the scale for CD, LD, ORDE and anisotropy signals.
Used for JASCO service engineers.

HT-OD conversion

Calibrates the HT-OD conversion equation. Used for JASCO
service engineers.

Maintenance

Used for JASCO service engineers.

Note:

In the CFR version, J-1000 must be registered to Workgroup before use. Refer

to the [Spectra Manager CFR Administrative Tools] manual for details about

registering the CD

spectrometer to Workgroup.
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213 Starting [Spectra Manager]
(1) After starting Windows, double-click the [Spectra Manager] icon located on the Windows

desktop. Type the username and password in the logon dialog box to display the window
in Fig. 2.21.

Note: [Spectra Manager] can also be started by selecting [Start] - [All Programs] -
[JASCOQ] - [Spectra Manager] from the Windows [Start] menu.

-

&8 Spectra Manager CFR o | B

Program User View Help

Q Administrator] Ttem Value

E'@ Instrument Full name Bdministratar

=68 1-1500 Division
*! Spectra Measurement Access level Administrators
‘iarkgroup Adminiztrator

--[&% Time Course Measurement

----- & validation

% Interval Scan Measurement

----- E Variable Temperature Measurem
E Temperature Interval Measuren
@ Temperature/Wavelength Scan M
Automatic Titration Measuremen
ﬁ Autematic Titration Scan Measun
-4 Ex/Em Spectra Measurement
ﬁ MCD Hysteresis Measurement
1'-3«4 Multiwavelength Stopped-Flow M
----- Hifl Stopped-Flow Measurement
=8 Analysis

----- HH Spectra Analysis

----- [ 145C0 Canvas

-\ Interval Data Analysis

----- 2 ORD-E Data Correction

B8 MCD Hysteresis Analysis

----- A+ 1-1500 Wavelength Correction Exper
-Fi# Polarimeter Analysis

‘orkeroup user .. Managers

4 (LI F

Figure 2.21 [Spectra Manager CFR] window
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(2) Start the [Spectra Measurement] program to measure a sample.

Double-click [Spectra Measurement] from the [Instrument] list of [Spectra Manager] to
start the program. The window in Fig. 2.22 is displayed.

w3 Spectra Measurement - J-1500/A000 SRR X
Eile Measure Control View Settings Help
300.0 |[om Acc. 01 10.16  mdeg 85.6 v
nm = =a 1
| 7| & | 0|3 .88 2@ = w i i
x
- 1
Information
Item Co *
= &3 J- 1500 051
I Serial Mo. ;
Cell units REC-5
= @Sample Infarmation 0
E Sample Name CD [mdeg]
Caone. = F
Salvent
E Gomment 0.5
] Parameters
Photometric m... ]
GO scale 201 -1 . ' . . . .
FL zcale k1]
DIT. 1 1000
Bandwidth 11 L
Measurement r. 300 N
Data pitch i 800
Scanning speed 100
E} Start mode It GO0k
E Bacaling core Mo ™
] T k HT [V]
» 400
Main units
Cell units 200
R5C-502/0000
Standard Cell Halder 0 : : : : : : : : :
200 220 240 260 280 300
[ ttem Wahe | Wavelength [nm]
Ready NUM

Figure 2.22 [Spectra Measurement] window
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21.4

Components of the Program Window

In this section, the [Spectra Analysis] program window is used as an example to explain
program operation components. The names of the various components (windows and dialog
boxes) are also described.

View window

[Spectra Analysis] shows multiple spectrum display windows (called “Views”) in the main
program window. Views have no dedicated menu bar, toolbar or status bar. Instead, the
toolbar buttons and other components in the [Spectra Analysis] program window can be
used for the active View window.

M Spectra Analysis

|_|:| Ef™")

W= e

@
olx|

e

E Spectra Analysis
=) View1

= View 2
=] View 3

Memory-1
Memory-2

Memary-3

Irem
User
Workgroup
Division
Company
Creation date
Sample name
Comment

Detailed inform...
4

1

Content

Administrator
Applab

JASCO
2010/10/20 8:52

File Edit View Processing Window Other Help
= ==
XY e @ $ & da
U g T e i SV N W ) o

| &2

View1 <Memony-1>

View 2 <Memory-2>

View 3 <Memory-3=

110
100

Int. 5ok

0
370 400

500
Wavelength [nm)]

600

Ready

Dialog boxes

Figure 2.23 “Views” in [Spectra Measurement] program window

Commands and menu items ending with an ellipsis (...) open a dialog box when clicked.
The opened dialog box usually contains parameters that must be specified. The [Styles]
dialog box from the [View] menu is used as an example to explain the names and
functions, as well as the operational rules for various sections of the dialog box.
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To display the [Styles] dialog box in Fig. 2.24, select [Styles...] from the [View] menu in the
[Spectra Analysis] program. The names of various sections of the dialog box are indicated

below.
Styles iﬁ.ﬂ
| Command button
sz, st avelength [nm] v|
Drop-down list —
Scale label | Cancel
[nterval
@ Auta Set a3
; —era— Check box
Text box i
50 |
Option button
Tick type: The colored dot (e)
/ Mane Oupsige—————— | Shows that an option
il = = has been selected.
Group @ |nzide Crozs
Decimal places: | Drefault - |
Dizplay the max. and min. xvalues at the
main ticks.

Figure 2.24 [Styles] dialog box
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2.2 Exiting the Program
Exiting [Spectra Manager]

2.21

(1) Select [Exit] from the [Program] menu to close [Spectra Manager].

] Note: [Spectra Manager] can also be exited by clicking the <Close> button.

&8 Spectra Manager CFR

Program  Instrument View Help

#7 Administrator
@R Instrument

500

- 4@ Spectra Measurement

--[&% Time Course Measurement

----- & validation

% Interval Scan Measurement

----- E Variable Temperature Measurem
E Temperature Interval Measuren
@ Temperature/Wavelength Scan M
Automatic Titration Measuremen
*[j Autematic Titration Scan Measun
-4 Ex/Em Spectra Measurement
ﬁ MCD Hysteresis Measurement

- By Multiwavelength Stopped-Flow M

----- Hifl Stopped-Flow Measurement

=8 Analysis

HH Spectra Analysis

[ 145C0 Canvas

-\ Interval Data Analysis

----- 2 ORD-E Data Correction

B8 MCD Hysteresis Analysis

A+ 1-1500 Wavelength Correction Exper
-Fi# Polarimeter Analysis

(LI 4

Item

@ Status

£ Model name
M Serial Mo,

Version

Contents
Idle
J-1500
AD0O

1.00.00 [Buil...

ROM version 1.00.00

Ready

Figure 2.25 [Spectra Manager CFR] window

[Spectra Manager] cannot be exited before closing the running measurement/analysis
programs. If programs are running, the dialog box in Fig. 2.26 is displayed. After clicking
the <OK> button, close the running programs.
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Spectra Manager @

Measurement program is currently running.
l % Please close the program to exit the Spectra Manager.

OK

Figure 2.26 Message when a program is still running

(2) Exiting Windows

Exit Windows in accordance with standard Windows operation procedures.

2.2.2  Turning off the PC and CD Spectrometer

(1) First, turn off the PC and monitor. Do not forget to turn off the monitor.

(2) Ensure that the sample compartment is empty, and then turn off the CD spectrometer.
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2.3 [Spectra Manager CFR] Program Reference
[Spectra Manager CFR] is an integrated software package that acts as a common platform for
the entire range of JASCO analytical instruments.

&8 Spectra Manager CFR = | 5 |
Program  Instrument View Help
#7 Administrator Item Contents
El@ Instrument @ status Idla
EI--% & Model name  1-1500

-y Spectra Measurement

--[&% Time Course Measurement
----- B validation

-2 Interval Scan Measurement

..... £7 variable TW; [Instrument] list
- {3 Temperature Interval Me3 Displays the names of instruments that are currently

{88 Temperature/Wavelength Scd available for use. For each instrument, a list of available
-[[fl Automatic Titration Measuren| programs is displayed. Start a program by double-clicking
-] Automatic Titration Scan Mea its name.

4@ Ex/Em Spectra Measurement
ﬁ MCD Hysteresis Measurement
-4 Multiwavelength Stopped-Flow M
----- bifl Stepped-Flow Measurement
= Analysis

----- H Spectragalysis

_____ B 1A5Co Ezgh[Analysis] list . o N

-\ Interval Data Analysis When an analysis program is installed, it is added to
this list. Start a program by double-clicking its name.

Ml Serigl Mo, ADDO
[ Version 1.00.00 [Buil...
@l ROM version  1.00.00

B8 MCD Hysteresis Analysis
----- A 1-1500 Wavelength Correction Exper
-Fi# Polarimeter Analysis

4 (LI F

Figure 2.27 [Spectra Manager CFR] window

The standard measurement and analysis programs are displayed in Fig. 2.27. When an
optional program is installed, it is added to one of these lists.

Note 1: The CD Spectrometer is also referred to as the “instrument” in this manual.

Note 2: “Communication” refers to sending a control signal from the PC to the CD
spectrometer or transferring measured data from the CD spectrometer to the
PC.
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Menu

[Program] menu

[Administrative Tools] Starts the [Administrative Tools] program.
[Change Password...] Changes the current password.
[Logoff...] Logs off the current user.
[Exit] Exits [Spectra Manager].
[User] menu
[Change Workgroup...] ‘ Changes the Workgroup.
[View] menu
[Status Bar] ‘ Shows/hides the status bar.
[Help] menu
[Contents] Displays the Help contents window.
[Search Topic] Displays the Help search function window.
[About...] Displays version information about the CD spectrometer
control driver.
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3. Accessory Registration Reference

The J-1000 series CD spectrometers and software automatically recognize an attached
accessory, display information about the accessory, and start registered programs based on
recognized accessories. This chapter provides information of installing and registering
accessories, the program that is started when an accessory is recognized, and the actions of
[Spectra Manager CFR] when recognizing an accessory.

3.1 Installing/Attaching an Accessory

Accessories for J-1000 series CD spectrometers are automatically recognized. Information
about the respective accessory is contained within the accessory itself. The accessory is
recognized when its cable is connected to the sample compartment connector. When installing
a J-1000 accessory, confirm that the accessory cable is properly connected to the CD
spectrometer connector.

Accessory connector

Accessory connecter
(for Peltier cell holder)

Figure 3.1 Location of J-1000 accessory connectors
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3.2 Precautions for Peltier Thermostatic Cell Holder

The electrical power for the Peltier thermostatic cell holder is supplied from the J-1000 series
CD spectrometer when this accessory is connected and detected by the instrument. When
power is being supplied, an icon is displayed on the status bar.

iﬂ Variable Temperature Measurement - 1-1500/A000 _ _ ‘ EI@E

File Measure Control View Settings Help
| 2735 |m|[temp. 19,99 ¢ | 17.46 mces| 63.8 @V |
= = 1 A - = n
ElIEEEIIEYS NN EIEE R PR 11
=
—— TG — T
Ttem Contents || CD [mdeg] 0 F
E & J-1500 zleep AL 1 1 1 1 1
{gg‘.‘ﬁerial Ma. AD0D
Cell units Mot attached 1000
= ﬁSamp\e Information = E
E} 5ample name HT [V] 400F I
B} Cone. oF . | . | . | . | .
E' Solvent 20 22 24 26 28 30
E} Comment Temperature [C]
= ZF|Parameters
E} Protametric m.. oD, HT Wavelengthinm) |Temperature Range{C)|  Legend Filename |
E}CD scale 200 mdee ] [ ] 2755 20 - 50
E}FL scale 200 mdee
@ DIT. 1 zec
@ Bandwidth 1.00 nm
[E) Waveleneth-1 2735 nm
't Bazeline corre.. Mo Correction it
=

ﬁ A LFIFI0-2IL
JFLC-435/C001

Control 2000 G Holder cee .
10 T ] 110 holder recognition icon

Sample Holder 2000 G
Sample Cell 2000 G

Peltier thermostatic cell

[ v
Ready NUM

Figure 3.2 Icon displayed on the status bar after the Peltier thermostatic cell holder has been
recognized
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3.21 Removing the Peltier Thermostatic Cell Holder

This section describes how to remove the Peltier thermostatic cell holder while the J-1000

series instrument is running.

(1) Click the cursor on the accessory icon to display the [Safely Remove Temp unit] pop-up
menu.

||
Safely Remove Temp Power unit

® b

Figure 3.3 Pop-up prompt for safely removing the thermostatic unit

(2) Left-click the command to display the [Safely Remove Thermostatic Unit] dialog box.

L 1

Safely Remove Temp. Power unit E3

l 3 Comfirm temp. power unit to be stopped.

Yes l | Mo |

Figure 3.4 [Safely Remove Thermostatic Unit] dialog box

(3) Click the <Yes> button. The electrical power supply for the Peltier thermostatic cell holder
will be stopped and the cell holder can now be safely removed.

Safely Remowve Temp. Power unit &J

This temp. power unit can now be safely removed from the cell unit.

OK

L

Figure 3.5 Confirmation message that thermostatic unit can be safely removed

To use the Peltier thermostatic cell holder again, reconnect its accessory cable to the
J-1000 series instrument.
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3.3 Registering Accessories
This section describes the procedure for registration of accessories used with the CD
spectrometer.

3.3.1 Registering an Automatically-Recognized Accessory
(1) Confirm that the instrument is turned on and that [Spectra Manager] is running.

(2) Connect the automatically-recognized accessory to the sample compartment. The
accessory name, accessory ID and serial number are automatically registered.

3.3.2 Registering an Accessory Requiring Manual Registration

Note: This operation can be performed only by Administrators.

(1) Confirm that the CD spectrometer is turned on and that [Spectra Manager] is running.
After starting [Administrative Tools], right-click the instrument name and select
[Properties...] (see Fig. 3.6).

=) Administrative Tools

Operation View Help

=) Administrative Tools Name
----- @y, System Policy {5 Configuration
_@ Instrument B Measurement Program
B2 E_ Properties...
-8 Analysis
Delete Instrument... Delete
+- 4§ User Col, -

+ Log Management

------ System Information
Workgroup

----- Administrator

Figure 3.6 J-1000 instrument shortcut menu
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3.3.21 Detectors
This section describes the procedure for registration of detectors used with the CD

spectrometer.
(1) Click the [Detectors] tab in Fig. 3.7. Select the type of detector from the [Type] drop-down

list.
Properties - 1-1500-4/A000461638 |
| Genelall Composition I Phaotometric mode | Detectors | Measuren| 4| *
Tvpe: ’ Detectar - ]
h ame odel Mame Sernial Mo,
[&] Standard DetectaPMT) Ph-539 ADD04PME:
Em Detector FDT-533 ADDDFDT
4| n | 3
Details:
| -~
bdd. || Delte..
[ aF. ] [ Cancel ]

Figure 3.7 [Detectors] tab in [Properties] dialog box
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Table 3.1 Accessories

Type
Standard WL Detector (PMT): PM-539
Extended WL Detector (ExPMT): EXPM-531
Extended WL Detector (InGaAs):
InGaAs-532
Extended WL Detector (APD) : EXAP-533
FDCD Detector (PMT): PMJ-534
FDCD Detector (ExPMT): EXPML-535
FDCD Detector (InGaAs): EXLGL-536
FDCD Detector (APD) : EXAPL-537
FL Intensity Detector : FDT-538
Em Detector: FDT-455
ORD-M Detector (PMT): PM-540
Extended WL Detector (InSb) : INSB-541
(only for J-1700)

For J-1100, only the dedicated wavelength range expansion detector (PMT) can be

selected.
(2) Click the <Add...> button to display the dialog box in Fig. 3.8.
Register Accessory [é]
Marme: Eutended WL Detectar[ExPT]
Aecessory D | EXPMAG31 (Dx4000f002) -
Serial Mo A005
Comment;
[ OF. ] | Cancel |

Figure 3.8 [Register Accessory] dialog box

(3) [Name]is automatically entered by selecting the accessory in the [Accessory ID]
drop-down list. Type the serial number and a comment as required, and then click the
<OK> button to register the accessory and display it in the list of registered accessories
(see Fig.3.9).
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B
Properties - 1-1500-4/A000461638 [

| General I Composition I Phatometric mode | Detectors | Measuren 4 |

Tvpe: [ Detectar - ]
Hame todel Mame Serial Mo
Standard Detector[PHT] Phd-539 AN004PR 5
(4] Em Detector FOT-533 ADDOTFDT
El Eutended WL Detectar[ExPMT]  EXPM-531 AD0G
4| 1 3
Details:

Delete...

[ 0k ][ Cancel ]

Figure 3.9 [Detectors] tab in [Properties] dialog box
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3.3.2.2 Measurement Units
This section describes the procedure for registration of measurement units used with the CD

spectrometer. For J-1100, this tab is not displayed.
(1) Click the [Measurement Units] tab in Fig. 3.10. Select the type of measurement unit from

the [Type] drop-down list.

Properties - J-1500/A003 |
| Phatometric rmode | Detectnrs| Meazurement Units | Call Units | Elutal it

Type:  |ORD Uni -
EE kodel M ame Serial Mo
& ORD Urit ORDM-401 BO0S

1| 1] b
Dretails:

MHame - ORD Uit p
biodel : ORDM-401

Aocessary D : Ow40000:01

Senal Ma. - BO0S

{ [ Delete. . Property. .

[ ]9 H Cancel ]

b

Figure 3.10 [Measurement Units] tab in [Properties] dialog box

Table 3.2 Accessories

Type
ORD Attachment
Fluorescence Monochromator
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(2) Click the <Add...> button to display the dialog box in Fig. 3.11.

(3)

[ Register Accessary ﬁj
Hame: ORD Uit
Accessory |D: | ORDM-520 [0x40000:03) v]
Serial Mo
Comment:
[ Ok ] [ Cancel ]

Figure 3.11 [Register Accessory] dialog box

[Name] is automatically entered by selecting the accessory in the [Accessory ID]
drop-down list. Type the serial number and a comment as required, and then click the
<OK> button to register the accessory and display it in the list of registered accessories
(see Fig. 3.12).

Properties - J-1500/A000 [
| Photarnetic mode I Detectu:ur$| Meazurement Unitz | Cell Units | Elataf ik
Tvpe: [EIFED Attachment 'r]
Mame b odel Mame Senal Mo
2 ORD Unit DRDM-520 BOO
1| 1] 3
Dretails:
M ame :ORD Urit -
b odel - ORDK-520
Aocezzam (D : Owd 000003
Senal Ma. - BOM
add. || Delete..

£ Ok, |[ Cancel ]

Figure 3.12 [Measurement Units] tab in [Properties] dialog box
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3.3.2.3 Cell Units

This section describes the procedure for registration of cell units used with the CD
spectrometer.

(1) Click the [Cell Units] tab in Fig. 3.13. Select the type of cell unit from the [Type] drop-down

list.
Properties - J-1500/A000 [
| Phiotometric mode | Detectors | Meazurement Units | Cell Urits | |4 |+
Type: | Cell Holder v
WEE todel Mame Serial Mo,
&l Standard Cell Halder RSC-RO2 Coaa
1| 1] 3
Dretails:
MHame : Standard Cell Halder -
b odel - RSC-ADZ2
Acceszory D : Dxd000030d
Serial Mo. : Co0a
Add... ] [ Delete... ] [ Froperty. ..
E oK. [ Cancel ]

Figure 3.13 [Cell Units] tab in [Properties] dialog box
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Table 3.3 Accessories

Type
Cell Holder
Temperature Controller
Flow Cell
Integration Sphere
FDCD Attachment
Double Beam UV Attachment
MCD Controller

Stopped Flow Controller

Cryostat Holder
High Temp. Cell Unit
For J-1100, only the cell holder and temperature controller can be selected.

(2) Click the <Add...> button to display the dialog box in Fig. 3.14.

[ Register Accessory ﬁw
Marre: Cylindrical Micro Cell Holder
Accesson D) | MA-406 [0x40000301) -
Serial Mo
Comment:
¢ ok | Cancel |

Figure 3.14 [Register Accessory] dialog box

(3) [Name]is automatically entered by selecting the accessory in the [Accessory ID]
drop-down list. Type the serial number and a comment as required, and then click the
<OK> button to register the accessory and display it in the list of registered accessories
(see Fig. 3.15).
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Properties - 1-1500/A000

S

| Phiotometric mode | Detectors | Meazurement Units | Cell Urits | |4 |+
Type: | Cell Holder v
WEE todel Mame Serial Mo,
&l Standard Cell Halder RSC-RO2 Coaa
£ Colindrical Micra Cell Halder MA-408 Coog
1| 1] 3
Dretails:
MHame : Standard Cell Halder -
b odel - RSC-ADZ2
Acceszory D : Dxd000030d
Serial Mo. : Co0a
| [ Delete... ] [ Property...
[ k. ] [ Cancel ]

Figure 3.15 [Cell Units] tab in [Properties] dialog box
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3.3.2.4 External Accessories
This section describes the procedure for registration of external accessories used with the CD
spectrometer. For J-1100, this tab is not displayed.

(1) Click the [External Accessories] tab in Fig. 3.16. Select the type of external accessory
from the [Type] drop-down list. For-1100, the [External Accessories] tab is not displayed.

Properties - 1-1500/A000 @1
| b eazurement Units | Cell Llnits| External Accessones I Adjustmen 4 |
Tvpe: [i-’-‘-.utu:usampler v]
M arne Model M arne Serial Mo.
1| i F
Dretails:

sdd. || Delte..

[ Ok ][ Cancel ]

L

Figure 3.16 [External Accessories] tab in [Properties] dialog box

Table 3.4 Accessories

Type
Automatic Titrator
Circulator
Autosampler
PAL Unit
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(2) Click the <Add...> button to display the dialog box in Fig. 3.17.

(3)

[ Register Accessory @1
Hame: Autogampler
Accessory D | ASU-800 (0240001 a02) - ]
Serial Mo
Comment:
| oK [ Cancel ]

Figure 3.17 [Register Accessory] dialog box

[Name] is automatically entered by selecting the accessory in the [Accessory ID]
drop-down list. Type the serial number and a comment as required, and then click the
<OK> button to register the accessory and display it in the list of registered accessories
(see Fig.3.18).

Properties - J-1500/A000 [
| b eazurement Units | Cell Llnits| External Accessones I Adjustren * |
Type: [.ﬂ.utusampler - ]
Mame bodel Mame Senal Mo
A Autozampler ASU-300 Doo3
1| 1] k
Dretailz:
M ame : Autozampler *
Model - AS1-800
Aocezzam (D 400071 a0
Senal Mo, - D003
Drriver wersion 2 1.02.02 [Build 2]
[
[ ] ] [ Cancel ]

Figure 3.18 [External Accessories] tab in [Properties] dialog box
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3.4 Actions of [Spectra Manager] When Recognizing an
Accessory

This section describes the actions of [Spectra Manager] running a measurement program
when an automatically-recognized accessory with registered programs is attached to or
removed from the CD spectrometer.

Note: Do not attach/remove an automatically-recognized accessory while the
program is displaying a dialog box or message.

3.4.1 When an Automatically-Recognized Accessory is Attached
When an automatically-recognized accessory is attached, a dialog box stating “An accessory
has been attached” is displayed, and information on that accessory is displayed on the
accessory bar.

wig Spectra Measurement - J-1500/A000 l=[3@] =
File Measure Control View Settings Help
300.0 [nm Acc.0M 3.50  mdeg 85.6 v
nm == = TN
| | & | 0| Ex!«-@@g =W,
x
Information 1
Item Co *
= & -1500 05-
{g's'."Serial Mo, I
. P ’
Gell units . Mot Accessory ﬁ
= @Sample Information
Sample Mame d
Cione. = & An accessony has been attached.
Salvent
Comment M ame: Standard Cell Holder
7] Parameters
Phaotometric m.. G todel: RSC-502
. L |
E1CD scale Gl SerialNo:  C£000
FL scale aor
DIT. 1
Bandwidth 1
Measurement v 300 -
Diata pitch I}
Scanning speed 100 L
E’ Start mode Imm GO0
E* Bazeline rorvs b T
L] m 3 HT [V]
® 400
Main units r
Mot connect 200-
_______ -
0 L | L | L | L | L
200 220 240 260 280 300
Wavelength [nm]
Ready MNUM
[ |

Figure 3.19 Message when an automatically-recognized accessory is being attached
while [Spectra Manager] and a measurement program are running
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3.4.2 When the Automatically-Recognized Accessory is Removed
When an automatically-recognized accessory is removed, a dialog box stating “An accessory
was removed” is displayed, and information on that accessory disappears from the accessory
bar.

-
W@ Spectra Measurement - J-1500/A000 |_ =N &2 _|
File Measure Control View Settings Help
&% | 300.0 [ | Acc.0M | 2038 |mies | 767 v
| = | | | B | = 9 il
x
Information 1
Item Co
[= & -1500 05k
Wl Serial Na. ;
Cell units Mot
= @Sample Information 0
Ersample Name CD [mdeq]
Conc. = F
Solvent 3
Comment Accessory @
E7] Parameters
=t Photometric m.. o]
CD — a1 % An accessory was removed. 1 1 1
FL scale 00—
DIT. 1
Blandwidth 11
Meazurement r.. 300
. . 800
Data pitch 1]
Scanning speed 100 r
Start mode Imm 6001
E Racaling rores Mo T
4 | 1 " HT [V]
= 400
Main units
Eig' Standard WL DetectorPMT) 200
Prd-539./4001 L
I 1 | 1 | 1 | 1
HT vakage: 0V Settings... 0 :
v 200 220 240 260 280 300
Wavelength [nm]
Ready MUM

Figure 3.20 Message when an automatically-recognized accessory is removed
while [Spectra Manager] and a measurement program are running
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3.5 Status Display for the CD Spectrometer

This section describes the display of the CD spectrometer status in a measurement program.

Main units
@ Standard DetectorPRT)
Phd-539/40004PM539
HT woltage: Ao * Settings...

% Mot connect
....... I

Status

0 v ater Leak [Sample Chamber)
@0 Temperature [Lamp]

' M2 gas Flow
o zighal Overload

Figure 3.21 Status of CD spectrometer

Water Leak (Sample
Chamber)

When water leakage occurs in the sample compartment, the green
indicator in the status box turns red. A stop valve, an optional
accessory, automatically prevents water from leaking.

Temperature (Lamp)

When the light source temperature exceeds 80 °C, the green
indicator turns red and the light source is turned off automatically.

N, gas Flow

When the nitrogen flow rate is less than the specified value, the
green indicator turns red. This item is displayed only when the
[Manually with sensor] or [Automatic (PC control)] flow meter is used.

Note 1: For the [Manually with sensor] type, the sensor
position can be changed and the flow rate can be
specified.

Note 2: For the [Automatic (PC control)] type, when the
flow rate is less than the idling flow rate specified in
the [Administrative Tools] program, the green
indicator turns red.

CD signal Overload

When the CD signal exceeds the upper limit of the measurement
range specified by [CD scale] or [FL scale] in the [Parameters] dialog
box, the green indicator turns red. Specify a larger CD or FL scale.
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4. Introduction to the [Spectra Measurement]
Program

This chapter describes how to use the [Spectra Measurement] program, including procedures
for starting the [Spectra Measurement] program, measuring the spectrum of a sample, and
saving and printing data, for practice in operating a JASCO CD spectrometer.

Explanations of the parameters have been kept to a minimum, with a focus on the flow of
operations. Follow the measurement procedures outlined below for practice in operating the
CD spectrometer. Refer to Chapter 6 “[Measure] Menu Program Reference” for details about
toolbar icons and menus, and to Chapter 7 “[Spectra Measurement] Program Menu
Reference” for details about the [Parameters...] command.

4.1 Procedures for the [Spectra Measurement] Program

This section describes procedures ranging from measuring a CD spectrum of an ammonium
d-10-camphorsulfonate solution to saving and printing the measurement data.

Starting the [Spectra Measurement] Program Refer to Section 4.2
!

Specifying Measurement Parameters Refer to Section 4.3
!

Measuring the Sample Refer to Section 4.4
l

Saving Spectra Refer to Section 4.5
!

Printing Results Refer to Section 4.6
!

Exiting the Program Refer to Section 4.7
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4.2 Starting the [Spectra Measurement] Program
To start the program, double-click [Spectra Measurement] from the [Instrument] list of [Spectra
Manager]. The window in Fig. 4.1 is displayed.

w3 Spectra Measurement - J-1500/A000 = | B | S
Eile Measure Control View Settings Help
300.0 | nm Acc.0M1 12.30 mdeg 88.5 v
nm = = .1
| | & | ENEIGE Pt eag=5 " 3:1
x
- 1
Information
Ttem Co *
= &3 J-1500 05l
Il Serial Mo. '
Cell units REC-5
= @Sample Ihformation 0
El Sample Name CD [mdeg]
Cane. = L
Solvent
El Gomment 0.5
7 Parameters
Photometric m.. o]
GD scale 20( - . . ' . . :
FL zcale 200
DIT. 1 1000
Bandwidth 11 L
Measurement r. 300 - |
Data pitch i 800
Scanning speed 100
El} Start mode Itmim go0t-
E% Bacaline crree Mo ™
4 T 3 HT [V]
x 400
Main units
Cell units 200
RSC-A02/0000
Standard Cell Halder 0 : : : : : : : : :
200 220 240 260 280 300
[ ttem Wahe | Wavelength [nm]
Ready NUM

Figure 4.1 [Spectra Measurement] window
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4.3 Specifying Measurement Parameters

(1) Select [Parameters...] from the [Measure] menu (or click the ﬂ button) to display the
dialog box in Fig. 4.2. The [Parameters] dialog box contains the [General], [Control],
[Information], and [Data] tabs. The [General] tab is open by default in the [Parameters]
dialog box. The page can be changed by clicking each tab at the top of the dialog box.

Note 1: In the CFR version, parameter history is automatically saved. It is therefore
necessary to specify or open the parameters before measurement.

Note 2: In the CFR version, Managers or Analysts authority is required to specify
parameters.

(2) The parameters can be switched between two modes: Basic mode and Advanced mode.
In Basic mode, the choice of parameters is partially limited. In Advanced mode, each
parameter is specified individually. The parameters described in this section are specified
in Basic mode. To switch between Basic and Advanced modes, click the <Basic Mode>
or <Advanced Mode> button.

(3) Specify the measurement parameters in the [General] tab as follows.

7] Parameters Advanced &J
General | Contral | Infarmation | Data |
FPhotometric: mode Ctark: R0 Hm
Channels Num: 2 End: 220
End. nm
Channel 1. [COC 'l Data pitch: 0lrm -
Channel 2: |HT 'l Start mode: |Immediatel_',' T|
Extemal 1 Scanning mode: | Continuousz N |

Extemal 2 Scanning speed: 100 némin v

CDscale  [200mdea1.0d0D |

FLscal:  [200mdea/1.0d0D  ~|

DIT.: 2 sec - Accumulation/cycle

¥ | Accumulation:

Mo, of 1
Bandwidth:  1.00 hm accumulations:
Slit width:; | 100
B azic Mode ]l Opeh... || Save.. || Default || k. || Cancel |

Figure 4.2 [General] tab in [Parameters] dialog box

Photometric mode
[Channels Num] 2
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[Channel 1] [CD]

[Channel 2] [HT]

[CD scale] 200 mdeg/1.0 dOD
[FL scale] 200 mdeg/1.0 dOD
[D.1.T] 2 sec
[Bandwidth] 1 nm
[Start] 350 nm
[End] 220 nm
[Data pitch] 0.1 nm
[Start mode] [Immediately]
[Scanning mode] [Continuous]
[Scanning speed] 100 nm/min
Accumulation/cycle

[Accumulation] Deselected

[No. of accumulations] 1

Note:

Select the appropriate [CD scale] for the sample to be measured.

Parameters can be set by using two methods: selecting from available options and
specifying numeric values and characters. An example of setting parameters by using
each method is given below.

1)

2)

Selecting from available options

The following example describes how to select the CD scale. Select the CD scale from
the available options in the [CD scale] drop-down list. Click the arrow to the right of the
box to display the full list of [CD scale] options (see Fig. 4.3). Select the desired CD
scale (in this example, 200 mdeg/1.0 dOD).

CD scale: (200 mdeg/10d0D |

20 mdee/ 005 dOD
200 mdee/1.0 0D
2000 mdees 1.0 dOD

Figure 4.3 [CD scale] drop-down list

Specifying numeric values and characters

The following example describes how to specify the start wavelength. Click the [Start]
text box to edit the start wavelength. When the cursor appears in the text box, values
can be entered. Type the desired wavelength (in the example in Fig. 4.2, 350 nm) in
the text box to set the start wavelength.
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(4) Specify the measurement parameters in the [Control] tab as follows.

r -
77 Parametars Basic Iﬁ
Gieneral | Control | Information I Data |

Correction

@ Mone (1 Bazeline

Shutter iz opened and closed automatically

[ Shutter is closed between measurements.

Advanced Mode ] [ Open... ][ Save.. ][ Drefault ][ k. ][ Cancel ]

Figure 4.4 [Control] tab in [Parameters] dialog box

Correction [None]
[Shutter is opened and closed automatically] Selected

[Shutter is closed between measurements.] Deselected
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(5) Click the [Information] tab. Type information in the [Sample name], [Operator], [Division],
[Comment], [Concentration] and [Solvent] text boxes as desired. The information entered
here is saved as comment information together with the spectral data when the spectra
are saved.

i -
77| Parameters Basic Iﬁ
omaon [ i

Sample name:

O peratar:

Drivizion:

Comment:

Concentration:
Solvent:

[] Dizplay the [Comments] dialog box before measurement

I.ﬂ.dvancedﬂude I I Open... H Save. . I I Diefault I [ ] ] I Cancel I

Figure 4.5 [Information] tab in [Parameters] dialog box

[Sample name] Enter as desired (maximum 63 characters).

[Operator] Enter an operator name (maximum 63 characters).

[Division] Enter a division name for the operator (maximum 127
characters).

[Comment] Enter a comment (maximum 127 characters).

[Concentration] Enter a sample concentration.

[Solvent] Enter a solvent name (maximum 127 characters).

[Display the [Comments] Deselected

dialog box before

measurement]

Note: In the CFR version, the [Operator] and [Division] text boxes cannot be

changed by the user.
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(6) Click the [Data] tab. Specify the [Save data], [Send data], and [Print] options for the
measured spectrum. In this example, select the [To Spectra Analysis] check box.

7] Parameters Basic

-

| General | Control I Infu:urmatiu:-n| Data |
Save data
[ &uto save
Browse. .
Date-Mo.
Send data
VI Ta Spechadnalyss
Frint
[ Erint data after measurement
Browse...
Advanced Mode ] [ Open... H Save. . ] [ Diefault ] [ ak. ] [ Cancel ]

Figure 4.6 [Data] tab in [Parameters] dialog box

[Auto save] Deselected
[To Spectra Analysis] Selected
[Print data after measurement] Deselected
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(7) Inthe CFR version, always save changes to the parameters. Click the <Save...> button to
display the dialog box in Fig. 4.7.

Save Parameters ﬁ

Save ; Data y

File name: | Save |

Save az ype: [F"arameter Files [* cdzp) "H Cancel ]
% Username ;| &dministrator

Pazsword

Heazon : Create -

Figure 4.7 [Save Parameters] dialog box

(8) After entering the file name, type a password and then click the <Save> button.

Note: When the parameters have not been saved, the following message is

displayed.
Parameters @

The parameters have been modified.
. I % Save the parameters before ending setup.

OK

b

Figure 4.8 Message when the parameters have not been saved
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4.4 Measuring the Sample

(1) Inserting the sample

Fill the cell with the sample, place it in the cell holder, and then close the lid of the sample
compartment.

(2) Measuring the sample

.

Select [Sample Measurement] from the [Measure] menu (or click the s button) to
measure the spectrum for the sample. The progress of the measurement is displayed in
the window (see Fig. 4.9).

.
wig Spectra Measurement - J-1500/A000 =NACN X
File Measure Control View Settings Help
3451 om Acc. 01 2.03 mdeg 2264 Vv
e nim == 3§ [1B]
|| S| DB W AN Q)| = w
x
Information 50
40
Ttem Co =
[ &3 J-1500 I
Wl Serial Na. ! 201
Cell units FisC-5
= @Sample Information
EtSample Name CD [mdeg] 0 W
Cone. = I
Sokvent 20
Comment |
T Parameters I
Phatametric m.. G 40
E1CD scale 200 50 '
FL scale aor
DIT. 1 1000
Bandwidth 1 |
Measurement r.. 350 B
Data pitch 1] 800
Seanning speed 100 I
E Start mode Imm 600
E' Racaline roree M i T
4 1T [ HT [V]
x 400
Mair units I
Cell units 200 T
RS C-A02/C000
Standard Cell Holder 0 : : . :
220 250 300 3580
[ them Wahie | Wavelength [nm]
Ready MUM

Figure 4.9 [Spectra Measurement] window

After measurement, the [Spectra Analysis] program starts and the measured data is
displayed in a window. This window is called a "View". Figure 4.10 shows an example of a
measured spectrum that has not yet been saved (Title bar: View <Memory-1>).

Note 1: When the [Spectra Analysis] program is already running, it is not automatically
displayed as the active window after measurement. Click [Spectra Analysis] on
the Windows task bar to display the program as the active window.
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Note 2: Data is not automatically transferred unless the [To Spectra Analysis] check
box is selected in the [Data] tab of the [Parameters] dialog box. To transfer

data, select [Send to Analysis] from the [File] menu (or click the button).

l specrs weciroc B U WL O awec )

File Edit View Processing Window Other Help
FH sk 2[[XY (e dddla B A= g B
|[Ashspmigtzt e AA NS ADRBEEZRT A LGABFEREO S

Dix|

W Spectra Analysis
= B3 view 1
N

0.06%_d-10-ACS_10mm_

Q) —— ,
Item Content

User

Division

Company Microsoft

Creation date 2013/02/21 11:05

Sample name d-10-ACS

Comment Cellzomm
Detailed infor...

250 300
Wavelength [nm)]

< 1 I

Ready

Figure 4.10 Spectrum View
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4.5 Saving Spectra

This section describes the procedure for saving spectra using the [Spectra Analysis] program.

Note: Spectra can also be saved by selecting [Save Data...] from the [File] menu (or
by clicking the & | button) in the [Spectra Measurement] program.

(1) Select [Save As...] from the [File] menu in the [Spectra Analysis] program to display the
dialog box in Fig. 4.11.

Save As Lé]
Save jn: | Data J F |
File narne; Save
Save as type: | Standard Files [*.jws] - | | Cancel |
% Uszername : | Admiristator
Paszword

Figure 4.11 [Save As] dialog box

(2) From the [Save in] drop-down list, select the folder in which to save the spectrum.

Note: In the CFR version, the [Save in] drop-down list cannot be used to select a
folder in which to save the data. Folder selection is limited by Administrators
using the [Administrative Tools] program. Refer to the [Administrative Tools]
program manual for details.

(3) Type the file name in the [File name] text box. In this example, type “d-10-ACS” as the file
name.

(4) After entering the file name, type a password and then click the <Save> button.

(5) The file name is appended with the extension “.jws” (“d-10-ACS.jws”), which is the
standard file type.

(6) After saving the data, the title bar of the View changes to “View (d-10-ACS.jws)”.

Note: Refer to the [Spectra Analysis] program manual for details about saving
spectra.
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4.6 Printing Results

Print the measured spectra using a connected printer as follows.

(1) Select [Print Setup...] from the [File] menu to display the dialog box in Fig. 4.12. The

content of this dialog box varies depending on the connected printer. Configure the
printer settings if necessary.

-

-
Print Setup e
Frinter
Mame: fiicrosoft ¥FS Document Writer - I l Properties... ]
Status: Ready
Type: Microsoft XFS Document Writer
‘Where: EFPSPart:
Comment:
FPaper Orientation
Size: IA4 v] 2 @) Fartrait
Source: lﬁ.ut-:-m:ati-:alh,r Selact - I ! Landscapa
Metwork... [ Ok ] [ Cancel ]
L

Figure 4.12 Example of [Print Setup] dialog box

(2) Select [Print...] from the [Eile] menu to print the data.

Note 1: Refer to the [Spectra Analysis] program manual for details about printing a
spectrum.

Note 2: In the CFR version, “Unsigned” will be watermarked on the printed page when
no creation signature is assigned to the measurement data.
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4.7 Exiting the Program
(1) Exiting the [Spectra Analysis] program

Select [Exit] from the [File] menu. The [Spectra Analysis] window closes, leaving the
[Spectra Measurement] window displayed.

Note: When there are unsaved spectra in the window, a warning message is
displayed. Perform the action recommended by the message. A message is
displayed for each unsaved spectrum.

Spectra Analysis Lﬁ,l

'.o.' '‘Mernaory-1' has been modified.

Do you want to save the changes 7

| Y¥es | | Mo | | Cancel

b

Figure 4.13 Message when data has not been saved

(2) Exiting the [Spectra Measurement] program

Select [Exit] from the [File] menu to close the [Spectra Measurement] program, leaving
the [Spectra Manager] window displayed.

(3) Exiting the [Spectra Manager] program

Select [Exit] from the [Program] menu.
(4) Exiting Windows

Exit Windows in accordance with standard Windows operation procedures.
(5) Turning off the PC and CD spectrometer

First, turn off the PC and monitor. Do not forget to turn off the monitor.

Ensure that the sample compartment is empty, and then turn off the CD spectrometer.
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5. Introduction to the [Time Course Measurement]
Program

This chapter describes how to use the [Time Course Measurement] program, including
procedures for starting the [Time Course Measurement] program, measuring the spectrum of a
sample, and saving and printing data, for practice in operating a JASCO CD spectrometer.
Explanations of the parameters have been kept to a minimum, with a focus on the flow of
operations. Follow the measurement procedures outlined below for practice in operating the
CD spectrometer. Refer to Chapter 6 “[Measure] Menu Program Reference for details about
toolbar icons and menus, and refer to Chapter 8 “[Time Course Measurement] Program Menu
Reference” for details about the [Parameters...] command.

5.1 Procedures for the [Time Course Measurement]
Program

This section describes procedures ranging from measuring CD time-course data for an
ammonium d-10-camphorsulfonate solution to saving and printing the measurement data.

Starting the [Time Course Measurement] Program Refer to Section 5.2

!

Specifying Measurement Parameters Refer to Section 5.3
!

Measuring the Sample Refer to Section 5.4
!

Saving Data Refer to Section 5.5
!

Printing Results Refer to Section 5.6
!

Exiting the Program Refer to Section 5.7
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5.2 Starting the [Time Course Measurement] Program
To start the program, double-click [Time Course Measurement] from the [Instrument] list of
[Spectra Manager]. The window in Fig. 5.1 is displayed.

_
[, Time Course Measurement - 1-1500-4/A000461638 | [ S

File Measure Control View Setfings Help
273.5 |om Acc.0M 1.47 mdeg 5.9 v
T 2d P EEIL N IAN® QG H=w i

1

Infarmation
Ttem Cantents it
B & J-1500-4 idle
{g's'."SeriaI Ha., A000461639 0.51
Cell unitz PTC-517 / &00..

B ¢y Sample Information
Sample Name

=1 Conec. _|| CDmdeg) ©
Solvent 3
Comment
Parameters
Photametric m.. GO, HT 0.5
E1CD scale 200 mdeg/ 10 d..
FL scale 200 mdee/ 10 d...
DIT. (=
Bandwidth 100 nm -1 ' ' '
Wavelength 2735 nm
Measurement r.. Al zec 1000
Data pitch 1.0 gec -
¢ 1 b
% 800
Main units
@ Standard Detector[PMT) 6001
PM-539/40004PM539
HT voltage: Auto ® HT[V]
400

Nat connect
....... I

200

0 1 ] 1 ] 1
Qtatie 0 20 40 50

Cell unitz Time [sec]

Ready NUM

w

Figure 5.1 [Time Course Measurement] window
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5.3 Specifying Measurement Parameters

(1) Select [Parameters...] from the [Measure] menu (or click the E button) to display the
dialog box in Fig. 5.2. The [Parameters] dialog box contains the [General], [Control],
[Information], and [Data] tabs. The [General] tab is open by default in the [Parameters]
dialog box. The page can be changed by clicking each tab at the top of the dialog box.

Note 1: In the CFR version, parameter history is automatically saved. It is therefore
necessary to specify or open the parameters before measurement.

Note 2: In the CFR version, Managers or Analysts authority is required to specify
parameters.

(2) The parameters can be switched between two modes: Basic mode and Advanced mode.
In Basic mode, the choice of parameters is partially limited. In Advanced mode, each
parameter is specified individually. The parameters described in this section are specified
in Basic mode. To switch between Basic and Advanced modes, click the <Basic Mode>
or <Advanced Mode> button.

(3) Specify the measurement parameters in the [General] tab as follows.

77 Parameters Basic Iél
Gieneral | Contral I Infarmmaticrn | Data |
Photametric mode wavelength: 2735 Fir
L =
Chanrels Mum: = Meazuring time: 60 ec v
Charinel 1: |ED v| Data pitch: 10gec -
Channel 2: |HT v| Start mode: ||I‘|‘|I'I‘|El:|iatE|_'r' "|
External.
External 2
CD scale:  [200mdeg/1.0d00 v |
FLical:  [200mdeg/1.0d0D |
DILT.: 1 zec -
Bandwidth:  1.00 nm
| Advanced Mode || Open... || Save. . || Diefault || aE. || Cancel |

Figure 5.2 [General] tab in [Parameters] dialog box

Photometric mode
[Channels Num] 2
[Channel 1] [CD]
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[Channel 2] [HT]

[CD scale] 200 mdeg/1.0 dOD
[FL scale] 200 mdeg/1.0 dOD
[D.I.T.] 1 sec

[Bandwidth] 1 nm
[Wavelength] 291 nm
[Measuring time] 60 sec

[Data pitch] 1 sec

[Start mode] [Immediately]

Note: Select the appropriate [CD scale] for the sample to be measured.

Parameters can be set by using two methods: selecting from available options and
specifying numeric values and characters. An example of setting parameters using each
method is given below.

1) Selecting from available options

The following example describes how to select the CD scale. Select the CD scale from
the available options in the [CD scale] drop-down list. Click the arrow to the right of the
box to display the full list of [CD scale] options (see Fig. 5.3). Select the desired CD
scale (in this example, 200 mdeg/1.0 dOD).

CDscale:  [200mdeg/1.040D  ~|
20 mdeg 0.0 dOD

200 mdegd1.0 dOD
2000 mdeg/1.0 40D
10000 mdeg/1.0 0D

Figure 5.3 [CD scale] drop-down list

2) Specifying numeric values and characters

The following example describes how to specify the wavelength. Click the
[Wavelength] text box to edit the wavelength. When the cursor appears in the text box,
values can be entered. Type the desired wavelength (in the example in Fig. 5.2, 291
nm) in the text box to set the wavelength.
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(4) Specify the measurement parameters in the [Control] tab as follows.

==

General | Contral |Infu:urmatiu:un| Data |

Comection

@ Mone

(71 Blank

[¥]55hutter i opened and clozed automaticallé

B azic Mode H Open... H Save. . H Diefault ][ ] ][ Cancel ]

Figure 5.4 [Control] tab in [Parameters] dialog box

Correction

[Shutter is opened and closed automatically]
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(5) Click the [Information] tab. Type information in the [Sample name], [Operator], [Division],
[Comment], [Concentration] and [Solvent] text boxes as desired. The information entered
here is saved as comment information together with the time-course data when the data
are saved.

.
77 Parameters Advancad Iﬁ
Information | Diata

Sample name:

O peratar:

Driwizion:

Comment:

Concentration:
Solvent:

[] Display the [Comments] dialog box before measurement

[ B azic Mode H Open... H Save. . H Diefault ][ ] 4 ][ Cancel ]

Figure 5.5 [Information] tab in [Parameters] dialog box

[Sample name] Enter as desired (maximum 63 characters).

[Operator] Enter an operator name (maximum 63 characters).

[Division] Enter a division name for the operator (maximum 127
characters).

[Comment] Enter as desired (maximum 127 characters).

[Concentration] Enter as desired.

[Solvent] Enter as desired (maximum 127 characters).

[Display the [Comments] Deselected

dialog box before

measurement]

Note: In the CFR version, the [Operator] and [Division] text boxes cannot be

changed by the user.
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(6) Click the [Data] tab. Specify the [Save data], [Send data], and [Print] options for the
measured data. In this example, select the [To Spectra Analysis] check box.

77 Parameters Advancad ﬁ
| General | Control I Infu:urmatiu:un| Data |
Save data
Auto zave
Save n: Browse. ..
Eormat; [rate-to.
String:
Send data
[] Ta Spectra Analysis
Prirt
[] Print data after measurement
Browse...
B azic Mode ] [ Open... ] [ Save. . ] [ Diefault ] [ ] ] [ Cancel ]

Figure 5.6 [Data] tab in [Parameters] dialog box

[Auto save] Deselected
[To Spectra Analysis] Selected
[Print data after measurement] Deselected
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(7) Inthe CFR version, always save changes to the parameters. Click the <Save...> button to
display the dialog box in Fig. 5.7.

Save Parameters @

Save ; Data y

File name: | | Save |

Save az ype: [F"arameter Files [* cdzp) "] [ Cancel ]
% Username ;| &dministrator

Pazsword

Heazon : todity parameters -

Figure 5.7 [Save Parameters] dialog box

(8) After entering the file name, type a password and then click the <Save> button.

Note: When the parameters have not been saved, the following message is

displayed.
[ Parameters Iﬁ )

The parameters have been moedified.
Pl I . Savethe parameters before ending setup,

0K

b

Figure 5.8 Message when the parameters have not been saved
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5.4 Measuring the Sample

(1) Inserting the sample

Fill the cell with the sample, place it in the cell holder, and then close the lid of the sample
compartment.

(2) Measuring the sample
Select [Sample Measurement] from the [Measure] menu (or click the s button) to

measure the time-course data for the sample. The progress of the measurement is
displayed in the window (see Fig. 5.9).

LT', Time Course Measurement - J-1500/A000 — = 53

Eile Measure Control View Settings Help

291.0 |nmm Acc.0M 14.98 mdes  46.6 v

—_— = nm B == 3 1
CiEi=p= ER-NENEP ﬂv@Q; HE iy
x
Information 2
Item Contents S
= & J-1500 idle
I8 Serial No. AD0D 10
Cell units Mot attached
= @Sample Information
Sample Name 0
E) Gone. CD [mdeq]
Solvent E
Comment
Parameters Ocdtm 101
Photametric m.. GO HT
E1oD scale 200 mdeg
FL scale 200 mdeg
DIT. 1 eec -20
E't Bandwidth 100 nm 1000
Wavelength 281 nm
Measurement r.. 10 sec
Data pitch 1.0 zec s00l-
Start mode Immediately
Bazeline corre.. Mo Gorrection
E% Shutter cantrnl fdarial i 00
=
Main units HT [V]
&igl Standard WL Detectar[PMT) A00
PH-533,4001 L
HT voltage: 0% Settings... 200F
@ Nat connect 0 W
- fe 0 2 4 6 8 10
Time [sec]
Ready NUM

Figure 5.9 [Spectra Measurement] window

After measurement, the [Spectra Analysis] program starts and the measured data is
displayed in the window. This window is called a "View". Figure 5.10 shows an example of
a measured spectrum that has not yet been saved (Title bar: View <Memory-1>).

Note 1: When the [Spectra Analysis] program is already running, it is not automatically
displayed as the active window after measurement. Click [Spectra Analysis] on
the Windows task bar to display the program as the active window.
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Note 2: Data is not automatically transferred unless the [To Spectra Analysis] check
box is selected in the [Data] tab of the [Parameters] dialog box. To transfer

data, select [Send to Analysis] from the [File] menu (or click the button).

B s moves LY T
Eile Edit View Processing Window QOther Help

FRE SR 7
XY #eor e ¢4 d My B

sA b ey P I AN S MERE BT R HGABEDNREE &L
HEw b i w B e

=

=)

W Spectra Analysis
= & view 1
B

Memory-1

Item

Content it
User

Time [sec]
Administrator
Worlkgroup Administrator
M ricimm i
< i | 3

Figure 5.10 Spectrum View (fluorescence spectra)
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5.5 Saving Time-Course Data

This section describes the procedure for saving time-course data using the [Spectra Analysis]
program.

Note: Data can also be saved by selecting [Save Data...] from the [File] menu (or by
clicking the | [& | button) in the [Spectra Measurement] program.

(1) Select [Save As...] from the [File] menu in the [Spectra Analysis] program to display the
dialog box in Fig. 5.11.

rSave As lﬁj
Save jn . Data J F 2 |

File name: | Save

Saveastyper | Standard Files [*jws) »| [ Cancel |
@] Username : | Administrator
Pazzword :

Figure 5.11 [Save Data] dialog box

(2) From the [Save in] drop-down list, select the folder in which to save the data.

Note: In the CFR version, the [Save in] drop-down list cannot be used to select a
folder in which to save the data. Folder selection is limited by Administrators
using the [Administrative Tools] program. Refer to the [Administrative Tools]
program manual for details.

(3) Type the file name in the [File name] text box. In this example, type “d-10-ACS” as the file
name.

(4) After entering the file name, type a password and then click the <Save> button.

(5) The file name is appended with the extension “.jws” (“d-10-ACS.jws”), which is the
standard file type.

(6) After saving the data, the title bar of the View changes to “View (d-10-ACS.jws)”.
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Note: Refer to the [Spectra Analysis] program manual for details about saving
spectra.

5.6 Printing Results

Print the measured spectra using a connected printer as follows.

(1) Select [Print Setup...] from the [File] menu to display the dialog box in Fig. 5.12. The
content of this dialog box varies depending on the connected printer. Configure the
printer settings if necessary.

Print Setup &J

Frinter

Mame: flicrosoft XFS Document Writer - | | Froperties... |
Status: Ready

Type: Microsoft XS Document Writer

‘Where: XFSFart:

Comment:

Faper Orientation

Size: |A4 v| N @) Portrait

Source: | Automatically Selact - | Landscape
Metwork.... [ Ok ] | Cancel

L

Figure 5.12 Example of [Print Setup] dialog box

(2) Select [Print...] from the [Eile] menu to print the data.

Note 1: Refer to the [Spectra Analysis] program manual for details about printing a
spectrum.

Note 2: In the CFR version, “Unsigned” will be watermarked on the printed page when
no creation signature is assigned to the measurement data.
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5.7 Exiting the Program
(1) Exiting the [Spectra Analysis] program

Select [Exit] from the [File] menu. The [Spectra Analysis] window closes, leaving the
[Spectra Measurement] window displayed.

Note: When there are unsaved data in the window, a warning message is displayed.
Perform the action recommended by the message. A message is displayed for
each unsaved set of data.

P "

Spectra Analysis @

'.6.' ‘Memory-1' has been modified.

Do you want to save the changes 7

| Yes | | Mo | | Cancel

Figure 5.13 Message when data have not been saved

(2) Exiting the [Time Course Measurement] program

Select [Exit] from the [File] menu to close [Time Course Measurement], leaving the
[Spectra Manager] window displayed.

(3) Exiting the [Spectra Manager] program

Select [Exit] from the [Program] menu.

(4) Exiting Windows

Exit Windows in accordance with standard Windows operation procedures.

(5) Turning off the PC and CD spectrometer
First, turn off the PC and monitor. Do not forget to turn off the monitor.

Ensure that the sample compartment is empty, and then turn off the CD spectrometer.
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6. Measurement Program Reference

This chapter describes common toolbar and menu commands for the [Spectra measurement],
[Time Course Measurement] and [Data Monitor] programs. Refer to Chapters 7 to 9 or the
[Help] menu for details about specific parameters for each measurement program.

Note 1: Refer to Table 6.1 for information about the availability of toolbar and menu
commands in the three programs.

Note 2: All toolbar and menu commands are not necessarily available for every
program.

The [Spectra Measurement] program reference describes the features of the [Spectra
Measurement] program for measuring a sample spectrum.

6.1 Overview of Measurement Programs
Starting the measurement program displays the window in Fig. 6.1.

- Monitor bar
- 1= 0 .
Wi Spectra Measurement - J-1500/A00 . Displays the current wavelength,[—
File Measure Control View Settings Help number of cycles or number of
260.0 | nm 0/3 =16.51 mdeg 13./]accumulations and photometric values.
|| 2 | |$ﬂ@@%®ﬂg = T
x|
— Toolbar
armation .
I ol Measurement , parameter settings can be set and
2m Ju] . .
o & 1500 other common functions can be performed using the
I8 Seria] Mo, i |buttons on this toolbar (see Table 6.1). These tool
GCell units Mot .| [buttons can be customized in the [Settings] menu.
El ¢l Sample Information
Ef Sample Name CD [mdeg] 0
E} CGone. A
El Solvent i
E Gomment ncl
= EParameters Inf ti b ~ N
E} Photometric m.. n_ ormation bar Data dlsplay field
10D seake Displays the current|  Ipisplays the data being measured. The
FL scale measurement parameters. . . .
EjDIT. , display format can be specified using the
. l=.‘\n " i 1000 [View] menu.
Main unit bar

Displays current detector 800 /

and alarm information for

J-1000. Detectors can be 600
controlled from this bar. HT[Accessory bar

\ Main Uit Displays information about attached
‘3%‘ Standard WL Detector(PMT) accessories. Some accessories can be

Fh-533/4001 controlled from this bar.
HT voltage: 0% Settirgs...
Wollage: etlings 0| 1 , | L | L
190 200 220 240 260

¥y Mot connect Wavelength [nm]
Ready NUM

Figure 6.1 Measurement program window ([Spectra Measurement])
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Table 6.1 Toolbar buttons and names

Button Name Reference Section Spectra Time Course Data
Measurement Measurement Monitor
= [Save] 6.2.1 [Save Data..] v v
it [Send to Analysis] 6.2.2 [Send to Analysis] 4 v
E‘ [Open Parameters] 6.2.3 [Open Parameters...] v v
ﬁ‘ [Save Parameters] 6.2.4 [Save Parameters...] 4 v
@ [Cancel] 6.3.1 [Cancel] v v
.fn.‘ " [Sample 6.3.2 [Sample Measurement] 4 v
Measurement]
=] s [Blank/Baseline 6.3.3 [Baseline Measurement] 4 v
Measurement] 6.3.4 [Blank Measurement]
= [DC Dark 6.3.5 [DC Dark Measurement] 4 v
Measurement]
Gml [Parameters] 6.3.6 [Parameters.. ] v v v
+%]  [Zero Clear] 6.4.1 [Zero Clear] v v v
[Shutter] 6.4.2 [Shutter...] v v v
4% [Move Wavelength] 6.4.3 [Move Wavelength...] v v v
i3 [Detector] 6.4.4 [Detector...] v v v
[Xe Lamp] 6.4.5 [Light Source...] v v v
i Lemel Note: Turns the xenon
lamp on or off.
(. [Hg Lamp] 6.4.5 [Light Source...] v v v
Note: Indicates the
status of the
mercury  lamp.
The lamp cannot
be turned on or
off by clicking the
button.
L [Scales] 6.5.1 [Scales.. ] v v
== [Patterns] 6.5.2 [Patterns.. ] v v v
i X [Fonts] 6.5.3 [Fonts ...] v v v
[Gridlines] 6.5.4 [Gridlines...] v 4 v
L [Styles] 6.5.5 [Styles.. ] v v v
Bl & [Digital] 6.5.12 [View Mode] v
B+l [Graph] 6.5.12 [View Mode] v
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Window

Title bar Displays the program name.

Menu bar Displays the menus for operation.

Monitor bar Displays from left to right the current wavelength, number of
cycles or number of accumulations and photometric values.

Toolbar Displays available tool buttons. These tool buttons can be

customized in the [Settings] menu.

Information bar

Displays the current measurement parameters.

Main unit bar

Displays current detector information and alarm information
for the J-1000 CD spectrometer.

Accessory bar

Displays information about the attached accessory.

Spectrum display field Displays the spectrum or time-course data being
measured.
Status bar Displays the current state of the instrument and an
explanation of the selected menu.
Menu
[File] menu Spectra Time Data
Measure- | Course Monitor
ment Measure-
ment
[Save Data...] Saves the spectrum with a new file v v
name.
[Send to Analysis] | Transfers the measured data to the v v
[Spectra Analysis] program.
[Open Selects a parameter file and opens v v
Parameters...] those parameters.
[Save Saves the currently specified v v
Parameters...] measurement parameters with the
entered file name.
[Open Baseline...] | Selects a baseline file and opens that v
baseline spectrum.
Note: In the CFR version, this
function is not available.
[Save Baseline...] | Saves the currently measured v
baseline spectrum with the entered
file name.
Note: In the CFR version, this
function is not available.
[Exit] Exits the measurement program and v v v
returns to [Spectra Manager].
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Note: This command is in the
[Measure] menu in the
[Data Monitor] program.

[Measure] menu

[Cancel] Cancels the measurement. v v
[Sample Measures the spectrum or v v
Measurement] time-course data for the sample.
[Baseline Measures the baseline spectrum for v
Measurement] baseline correction.
[Blank Measures the blank for blank 4
Measurement] correction.
[DC Dark | Measures the dark spectrum for dark v v
Measurement] correction.
[Parameters...] Specifies parameters and saves or v v v
opens the measurement parameters.
[Control] menu
[Zero Clear] Sets the photometric value of ORD-M v v v
or fluorescence intensity at the
current wavelength to zero.
[Shutter...] Opens/closes the shutter. v v v
[Move Moves the CD  spectrometer v v v
Wavelength...] wavelength to the desired
wavelength.
[Detector...] Sets the detector sensitivity. v v v
[Light Source] Turns on or off the xenon lamp. v v v
[Nitrogen Specifies the flow rate of nitrogen v v v
Flowrate...] gas. This command is only displayed
when [Automatic (PC control)] is
selected for the nitrogen flow meter.
[Select Selects a detector. v v v
Detector...]
[Select Selects an accessory. v v v
Accessory...]
[View] menu
[Scales...] Specifies the display scale for the v v
spectrum or time-course data.
[Patterns...] Selects the display color and line v v
style for the spectrum or time-course
data.
[Fonts...] Specifies the display font for the v v

spectrum or time-course data.

77



[Gridlines...] Shows/hides the gridlines for the v v
spectrum or time-course data.
[Styles...] Specifies the display style for the V4 v
spectrum or time-course data.
[Overlay] Overlays spectra or time-course data v v
when cycle measurement is selected.
[Select Graph...] Selects the graph to be displayed on v v
the CD spectrum display field.
[Information Bar] | Shows/hides the information bar. v v v
[Accessory Bar] Shows/hides the accessory bar. v v v
[Toolbars] Shows/hides toolbars. v v v
[Status Bar] Shows/hides the status bar. v v v
[View Mode] Displays the photometric value in v
digital or graph mode.
[Graph View] Selects the graph to be displayed v
when graph mode is selected for the
photometric value display.
[Settings] menu
[Default Specifies measurement parameters v v
Parameters...] for running the [Spectra
Measurement] and [Time Course
Measurement] programs based on
the currently recognized accessory.
Note: In the CFR version, this
function is not available.
[Customize Customizes and shows/hides v v 4
Toolbar...] toolbars.
[Monitor Bar...] Customizes the style of the monitor v v v
bar.
[Help] menu
[About...] Displays version information for the v v v

program.
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6.2 [File] Menu

Saves or opens a measured data or parameter file.

6.2.1 [Save Data...]

Saves the measured data with a new file name.

Note: This operation can also be performed by clicking the tool button [& [Save].

Save data Iﬁ1

Save jn ; Data

File name: Save |

Save az type: Standard Files [*.jws] *] [ Cancel ]

Figure 6.2 [Save data] dialog box

[Save in] list Selects a drive or folder to browse using the drop-down list. Files
saved in the currently opened folder are displayed in the file name
list.

File name list Lists the files in the currently opened folder. Use as a reference
when naming a file.

[File name] Enters a file name for saving the measured data.

An extension may be omitted.

[Save as type] Selects the files (type of extension) to display in the file name list.

Files other than Standard Files (*.jws) cannot be selected.
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<Save> Saves the measured data and closes the dialog box. In the CFR
version, an electronic signature is required for saving data.

Creation Signature Iﬁ

% zername : Adminigtrator
|

Paszword :

[ SiEn ] I Cancel J

Figure 6.3 [Creation Signature] dialog box

<Cancel> Closes the dialog box without saving the measured data.

Note: In the CFR version, the [Save in] drop-down list cannot be used to select a
folder. However, a subfolder within the prespecified folder can be selected.

6.2.2 [Send to Analysis]

Transfers the measured data to the [Spectra Analysis] program. Selecting the [To Spectra
Analysis] check box in the [Data] tab of the [Parameters] dialog box from the [Measure] menu
automatically transfers the measured spectrum to the [Spectra Analysis] program after
measurement.

When a value of 2 or more is specified for the number of cycles in the [Parameters] dialog box,
the dialog box in Fig. 6.4 is displayed.

Send to Analysis [ﬁj

Select the data to send to Spectra Snalvsis.

[] Memary-1 Select All

[] Memory-2
[] Memory-2

[ oaesl ]

Figure 6.4 [Send to Analysis] dialog box

Select the check boxes for the data to send to the [Spectra Analysis] program (or click the
<Select All> button to send all data), and then click the <OK> button.

Note: This operation can also be performed by clicking the tool button |t [Send to
Analysis].
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6.2.3 [Open Parameters...]

Selects a parameter file and opens those parameters.

Note 1: This operation can also be performed by clicking the tool button EJ [Open

Parameters].
Note 2: The dialog box in Fig. 6.5 displays only the parameter files for the currently
attached accessory.
Open Parameters [&1
Look ir: , Data ) i |

File name: | Open |

Files of type: Farameter Files [, cdsp) *H Cancel I

Figure 6.5 [Open Parameters] dialog box

[Look in] list Selects a drive and folder to browse using the drop-down list.
Files saved in the currently opened folder are displayed in the file
name list.

File name list Lists the files in the currently opened folder. Selects the file name

of the parameters to open.

[File name] Enters the file name for the parameters to open.
An extension may be omitted since the appropriate extension for
the measurement program is automatically appended.

[Files of type] Selects the files (type of extension) to display in the file name list.
Files other than Parameter Files (having the appropriate
extension for the measurement program) cannot be selected.

<Open> Opens a parameter file and closes the dialog box.

<Cancel> Closes the dialog box without opening a parameter file.

Note: In the CFR version, the [Look in] drop-down list cannot be used to select a
folder. However, a subfolder within the prespecified folder can be selected.
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6.2.4 [Save Parameters...]
Saves the currently specified measurement parameters with the entered file name.

Note: This operation can also be performed by clicking the tool button [l [Save

Parameters].

o

Save Parameters

Save as ype:

Save in: C ? |
File name: | Save |

IF"arameter Filez [*.cdzp]

"’H Cancel I

% Username ;| &dministrator
Pazsword
Heazon : todity parameters -
Figure 6.6 [Save Parameters] dialog box
[Save in] list Selects a drive or folder to browse using the drop-down list. Files

saved in the currently opened folder are displayed in the file name
list.

File name list

Lists the files in the currently opened folder. Use as a reference
when naming a file.

[File name]

Enters a file name for saving parameters.
An extension may be omitted since the appropriate extension for
the measurement program is automatically appended.

[Save as type]

Selects the files (type of extension) to display in the file name list.
Files other than Parameter Files (having the appropriate extension
for the measurement program) cannot be selected.

[Username]

Displays the name of the logged-on user. This cannot be edited.

[Password]

In the CFR version, an electronic signature is required for saving
parameters. Type a password in the text box.
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[Reason] Selects a reason for saving the parameters. This cannot be
selected when new parameters are created. After modifying
parameters, select [Other] from the drop-down list to activate the
text box for typing the reason.

<Save> Saves the parameter file and closes the dialog box.

<Cancel> Closes the dialog box without saving the parameter file.

Note: In the CFR version, the [Save in] drop-down list cannot be used to select a
folder. However, a subfolder within the prespecified folder can be selected.

6.2.5 [Open Baseline...]

Selects a baseline file and opens that baseline. When a baseline file is opened, the sample
spectrum is corrected by using the opened baseline spectrum.

Note 1: In the CFR version, this function is not available.
Note 2: The following dialog box displays only the baseline files for the currently
attached accessory.

Open Baseline Iﬁ

Lok jm: . Data v‘ Qo T e

Files of type: Bazeline File [*.cdbsl) *] [ Cancel ]

Preview

Figure 6.7 [Open Baseline] dialog box

Click the <Preview> button in Fig. 6.6 to display the spectrum of the selected baseline file
(see Fig. 6.7).
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Open Baseline @
Lack | Data - J ¥
File narme:
Files of type: Baseline File [~ edb) *| [ Ccancel |
100
80
60
%T [
]
201
ol . | . | . | .
4000 3000 2000 1000 400
Wavenumber [cm-1]
Figure 6.8 [Open Baseline] dialog box
[Look in] list Selects a drive or folder to browse using the drop-down list. Files

saved in the currently opened folder are displayed in the file
name list.

File name list

Lists the files in the currently opened folder. Selects the file name
of the baseline spectrum to open.

[File name]

Enters the file name of the baseline spectrum to open.
An extension may be omitted since the extension “.cdbsl” is
automatically appended.

[Files of type]

Selects the files (type of extension) to display in the file name list.
Files other than Baseline Files (*.cdbsl) cannot be selected.

<Preview> Displays the baseline spectrum and information about the
selected file (see Fig. 6.8).

<Open> Opens the baseline file and closes the dialog box.

<Cancel> Closes the dialog box without opening a baseline file.
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6.2.6 [Save Baseline...]

Saves the currently measured baseline spectrum with the entered file name.

] Note: In the CFR version, this function is not available.

[ Save Baseline l&j
Savein  Data E D2 |[E)E
File name: |  Save |
Saveaslpe: | Bassline File [* odbsl) | [ Ccancel |
] Figure 6.9 [Save Baseline] dialog box
[Save in] list Selects a drive or folder to browse using the drop-down list. Files

saved in the currently opened folder are displayed in the file
name list.

File name list

Lists the files in the currently opened folder. Use as a reference
when naming a file.

[File name] Enters a file name for saving the baseline spectrum.
An extension may be omitted since the extension “.cdbsl’ is
automatically appended.

[Save as type] Selects the files (type of extension) to display in the file name list.
Files other than Baseline Files (*.cdbsl) cannot be selected.

<Save> Saves the measured baseline spectrum and closes the dialog
box.

<Cancel> Closes the dialog box without saving the measured baseline
spectrum.

6.2.7  [Exit]

Exits the [Spectra Measurement] program.
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6.3 [Measure] Menu
Starts or cancels the measurement, and specifies the measurement parameters.

6.3.1 [Cancel]

Cancels the measurement. A dialog box to confirm whether to keep the measurement data is
displayed.

Note: This operation can also be performed by clicking the tool button @ [Cancell].

[ Stop =)

Meazurement will be ztopped.
Do you want to keep this data ?
To continue the measurement click,

P Yes | | Mo | | Cancel |

Figure 6.10 [Cancel] dialog box

<Yes> Keeps the measured spectrum.
<No> Discards the measured spectrum.
<Cancel> Continues the measurement.

6.3.2 [Sample Measurement]

Measures the CD spectrum of the sample. Selecting the [To Spectra Analysis] check box in the
[Data] tab of the [Parameters] dialog box from the [Measure] menu automatically transfers the
measured data to the [Spectra Analysis] program after measurement. The measured data is
displayed in a new View.

Note: This operation can also be performed by clicking the tool button .. [Sample]
or pressing the measurement start button of the CD spectrometer.
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6.3.3 [Baseline Measurement]

Measures the baseline spectrum for baseline correction. Available if [Baseline] is selected in
the [Control] tab of the [Parameters] dialog box.

Baseline correction removes the effects of solvents and additional agents other than the target
sample. The true sample spectrum is obtained by subtracting the baseline spectrum from the
measured spectrum.

Confirm that the sample for baseline measurement has been inserted, and then click the
<Measure> button.

Note: This operation can also be performed by clicking the tool button |£., [Baseline

Measurement]. When the dialog box in Fig. 6.11 is displayed, the baseline
measurement can also be started by pressing the <Measure> buftton.

r N
Baseline Measurement [ﬁ,l

Click the [Meazure] button, after preparnng for bazeline
measurement.

| Cancel |

Figure 6.11 [Baseline Measurement] dialog box

<Measure> Measures the baseline spectrum for baseline correction.
<Cancel> Closes the [Baseline Measurement] dialog box without measuring the
baseline

6.3.4 [Blank Measurement]

Measures the blank data for blank correction. Available if [Blank] is selected in the [Control] tab
of the [Parameters] dialog box.

Blank correction removes the effects of solvents and additional agents other than the target
sample. The sample signal is obtained by subtracting the blank data from the data obtained
during measurement of the sample.

Confirm that the blank has been inserted, and then click the <Measure> button.

Note: This operation can also be performed by clicking the tool button £, [Blank

Measurement]. When the dialog box in Fig. 6.12 is displayed, the blank
measurement can also be started by pressing the <Measure> buftton.
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Blank Measurement I&

Click the [Meazure] button after preparing for blank,
measurement.

| Cancel |

Figure 6.12 [Blank Measurement] dialog box

<Measure> Measures the blank spectrum for blank correction.
<Cancel> Closes the [Blank Measurement] dialog box without measuring the
blank.

6.3.5 [DC Dark Measurement]

Measures the photometric value for dark correction. Available if the InGaAs photoconductive
detector is used.

Note: This operation can also be performed by clicking the tool button D, [DC Dark
Measurement].

DC Dark Measurement &J

Click the [Measzure] button after preparing for DC Dark,
Corectioh measurement,

| Cancel |

Figure 6.13 [DC Dark Measurement] dialog box

<Measure> Measures the photometric value for dark correction.
<Cancel> Closes the [DC Dark Measurement] dialog box without measuring the
dark current.

6.3.6 [Parameters...]
Specifies the measurement parameters. Refer to each measurement program reference.
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6.4 [Control] menu
6.4.1 [Zero Clear]

Sets the photometric value of the ORD-M or fluorescence intensity to zero. Available if an
ORD-M or fluorescence detector is connected.

Note: This operation can also be performed by clicking the tool button &l [Zero
Clear].

6.4.2 [Shutter]

Opens/closes the shutter.

Note: This operation can also be performed by clicking the tool button <&
[Shutter].

6.4.3 [Move Wavelength...]

Moves the wavelength of the CD spectrometer to the desired wavelength. When the
measurement is started, data acquisition begins once the wavelength returns to the value
specified in [Parameters].

Mowve Wavelength

=
Move to 30 Him
| Cancel |

Cancel

Figure 6.14 [Move Wavelength] dialog box

[Move to] Specifies the wavelength.
J-1100: 180 to 600 nm
J-1500: 163 to 1600 nm
J-1700: 163 to 2500 nm

<OK> Moves the wavelength of the CD spectrometer to the specified
wavelength and closes the dialog box.
<Cancel> Closes the dialog box without applying any changes to the [Move

Wavelength] settings.

Note: This operation can also be performed by clicking the tool button 4w [Move
Wavelength].
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6.4.4 [Detector ...]

Specifies the sensitivity for monitoring the photometric value.

1> Detector Control o X
Detector Control = [ | Displa
w i D Detector | FL Datestor]
By @ HT 64.3 v pd  0.033 M
0.0 £ Detector | FL Datectar] Extended WL DetectorlnGats)
O H - v
@ Standard WL Detecta(PMT) EXIG-532/4002
PM.538/4001
i =
HT wolt modk F 400 600 B =
ol At =
wolt mode: o 0 €0y

Figure 6.15 [Detector Control] dialog box (Lleft: PMT, APD) (right: InGaAS, InSb)

Display
[HT] Displays the HT voltage for the detector.
[DC] Displays the DC voltage for the detector.
[HT volt mode]
[Auto] Automatically sets the applied voltage for the photomultiplier tube.
[Manual] Manually sets the applied voltage for the photomultiplier tube.
[Off] Sets the detector voltage off.
[HT voltage] Specifies the photomultiplier tube voltage when [Manual] is selected
for [HT volt mode].
Setting range: 0 to 1000 V
[Gain] Selects the voltage gain for the InGaAs or InSb detector.
Options: x1, x10, x100
<Apply> Sets the sensitivity of the CD spectrometer to the specified
sensitivity.
<Cancel> Closes the dialog box without applying any changes to the [Detector

Control] settings.

Note: This operation can also be performed by clicking the tool button &
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6.4.5 [Light Source...]

Turn on/off the light source.

Light Source Control I&

Henan lamp

[ J kercury lamp:
10.0 haurs l Qx s 0.0 hours QHF

E ak, { I Cancel I

b

Light Source Contro Lﬁj

Henon lamp: Halogen lamp: lQ | bl ercuny larmp:
1

[
22 8 haours & 2.9 hours \_‘, 2.4 howrs QHF

[ Ok, ] I Cancel I

Figure 6.16 [Light Source Control] dialog box J-1100/1500 (top) J-1700 (bottom)

Note 1: This operation can also be performed by clicking the tool button Q
[Light Source].

Note 2: @; indicates the status of the mercury lamp. The lamp cannot be turned on or
off by clicking the button.

6.4.6 [Nitrogen Flowrate...]
Controls the nitrogen gas flow rate. Available if a PC-controlled nitrogen-gas auto flow meter is
selected.

Mitrogen-gas Autoflowmeter [ﬁ

Current flus: “ Lémin.

Mitragen-gas flus

Lriif. | &pply

Figure 6.17 [Nitrogen Gas Auto Flow Meter] dialog box

Note: This command is displayed when the PC-controlled nitrogen gas auto flow
meter is selected in [Administrative Tools].
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6.4.7 [Select Detector...]

Recognizes a detector manually. Select the detector to use and click the <OK> button. A
dialog box stating “Connecting to the detector...” is displayed.

Select Detectar @

Select an acceszony from the reqistered detectars in the fallowing hst.

Regiztered CO detectors: - Automatic recognition

Type Mame Statuz Sernal Mo,
Standard WL Detector.. PM-539 Connected A001

Registered FL detectors:

Type M ame Statuz Sernial Mo,
[C1{E]FOCD Detectarf4PD]  EXAPL-S537 Mot connect... A002
E ok [ Cancel ]

Figure 6.18 [Select Detector] dialog box
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6.4.8 [Select Accessory...]

Selects an accessory (cell unit, external accessories or measurement units) to be used. After
clicking the <OK> button, the message "The accessory was attached successfully.” is
displayed.

Select Accessory l&

Select an accessany from the registered accessonies in the following list,

Registered cell units:

Type M ame Statusz Senal Mo.
ol Standard Cel... SCE-846 Connectad SCE-245

Reqgistered external accesszones:

Type W E= Statuz 5

[ Ok, ] [ Canicel ]

Figure 6.19 [Select Accessory] dialog box

Note: Inthe CFR version, the function for automatically starting registered programs
for accessories is not provided.
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6.4.9 [Accessory Model Number]

When an accessory that has been registered is attached, the accessory name is displayed as
a command on the [Control] menu (see Fig. 6.20). Select the command to control the attached
accessory.

Control

Zero Clear
Shutter...

Mowve Wawvelength...
Detector...

Light Source...

Mitrogen Flowrate...

Accessory model
Select Detector... number
Select Accessory.. /
JFLC-498

Figure 6.20 [Control] dialog box

Note 1: Use this function to return the temperature of the Peltier device to room
temperature after measuring data at high or low temperatures to set a target
temperature after inserting a sample.

Note 2: This operation can also be performed by clicking the <Setting...> button in the
accessory bar.
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6.5 [View] Menu

Specifies the view options.

6.5.1 [Scales.

.

Specifies the display scale for the spectrum.

-

Scales [ﬁjw
Erame number 1 :
10
Auto
-10
200 Autn ann
[ ] ] | Cancel | | Apply |

Figure 6.21 [Scales] dialog box

[Frame number]

Selects the graph for which to change the scales.

Horizontal axis

Enters the scale for the horizontal axis. Selecting the [Auto]
check box displays the entire range irrespective of the entered
values.

Vertical axis Enters the scale for the vertical axis. Selecting the [Auto] check
box displays the graph at the optimal scale for the specified
horizontal axis range.

<OK> Applies the changes to the [Scales] settings and closes the
dialog box.

<Cancel> Closes the dialog box without applying any changes to the
[Scales] settings.

<Apply> Applies the specified scales to the graph selected in [Frame

number].

Note:  This operation can also be performed by clicking the tool button 1 [Scales].
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6.5.2 [Patterns...]

Selects the display color and line style for the spectrum.

-

Patterns @1

Item : |§Speu:trum'| Tl [ Ok ]

Line Cancel |
Color _ - Sample

Line style : —

Ling width: —— o

Set as default

Figure 6.22 [Patterns] dialog box

[ltem] Selects an item from spectra 1 to 16, frame, gridlines, and auxiliary
gridlines to change its color and line style.

[Color] Shows the available colors for the selected item in the drop-down list.

[Line style] Shows the available line styles. The currently selected item in the
[ltem] drop-down list is displayed with the selected line style.

[Line width] Shows the available line widths. The currently selected item in the
[ltem] drop-down list is displayed with the selected line width.

Sample Displays a sample of the selected pattern.

[Set as default] Applies the selected patterns to all subsequently opened Views.

<OK> Applies the changes to the [Patterns] settings and closes the dialog
box.

<Cancel> Closes the dialog box without applying any changes to the [Patterns]

settings.

Note: This operation can also be performed by clicking the tool button ==

[Patterns].
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6.5.3

[Fonts...]

Specifies the display font for the data.

Fonts
It : li»’-‘n.:-tis label
Fort name ; Style
Arial Regular
E— -
Arnial Black Italic:
Batang Buald
(} BatangChe Bold ltalic x
Hr Bitstream Vera Sans 16 T A Set 55
B Bitstrearn Wera Sans M 18 default
B Bitstream Vera Seif T 20 i
Effects Sample Orientation
[ Strike: out @ Horizontal
[T Underline AaBbYyZz Yertical
Color ;
[ [ - | Soript:
Western -

Figure 6.23 [Fonts] dialog box

[item]

Selects an item to change its font settings.
[Axis label]: Character ([CD (mdeg)], [nm], or other)
[Scale label]: Numeric value

[Font name]

Lists available font names.

[Style] Lists available styles.

[Size] Lists available sizes.

Effects Selects strikeout and underline effects.
[Strike out]: Draws a line through the middle of the text.
[Underline]: Underlines the text.

Sample Displays a sample of the specified font.

Orientation Selects the orientation for displaying the axis label.
[Horizontal]: Displays the y-axis label horizontally
[Vertical]: Displays the y-axis label vertically

[Set as default] Applies the specified fonts to all subsequently opened Views.

[Color] Shows the available colors for the selected item in the drop-down
list.

[Script] Selects the language for the specified font.

<OK> Applies the changes to the [Fonts] settings and closes the dialog
box.

<Cancel> Closes the dialog box without applying any changes to the [Fonts]
settings.

Note: This operation can also be performed by clicking the tool button “#  [Fonts].
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6.5.4 [Gridlines...]
Shows/hides the gridlines for the data.

Gridlines [=5]
b ain gridlines

Horizontat Caricel |

Wertical

Set az
B o default
Agliary gridlines

Harizontal

Wertical

Figure 6.24 [Gridlines] dialog box

Main gridlines
[Horizontal] Displays major horizontal axis gridlines.
[Vertical] Displays major vertical axis gridlines.
Auxiliary gridlines
[Horizontal] Displays minor horizontal axis gridlines.
[Vertical] Displays minor vertical axis gridlines.
[Set as default] Applies the selected gridlines to all subsequently opened Views.
<OK> Applies the changes to the [Gridlines] settings and closes the
dialog box.
<Cancel> Closes the dialog box without applying any changes to the
[Gridlines] settings.

Note: This operation can also be performed by clicking the tool button
[Gridlines].
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6.5.5 [Styles..

]

Specifies the display style for the spectrum.

Styles i
i |s’WaveIength [rirn] P |
Scale label | Cancel

Interval
@ Auto Set az
Manual 100 defaul
50
Tick type:
MHone Outzide
@ |nzide Crozs
Decimal places: Drefault -
Dizplay the max. and min. xvalues at the
mnain ticks.

Figure 6.25 [Styles] dialog box

[Axis] Selects an item to change its display style.
Interval
[Auto] Automatically selects the gridline format.
[Manual] Manually specifies the gridline format for the main and auxiliary
scales.
Tick type
[None] Displays no ticks on the axis
[Outside] Displays ticks on the outside of the axis.
[Inside] Displays ticks on the inside of the axis.
[Cross] Displays ticks on both sides of the axis.

[Decimal places]

Selects the number of decimal places for the display values on
the horizontal and vertical axes.

[Display the max. and min. | Displays the maximum and minimum values at the main ticks.
values at the main ticks] Values at the auxiliary ticks are not displayed.

[Set as default] Applies the specified styles to all subsequently opened Views.

<OK> Applies the changes to the [Styles] settings and closes the
dialog box.

<Cancel> Closes the dialog box without applying any changes to the

[Styles] settings.

Note: This operation can also be performed by clicking the tool button i, [Styles].
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6.5.6 [Overlay]

Overlays the spectra in the spectrum measurement display field when cycle measurement is
selected.

6.5.7 [Select Graph...]
Selects the graphs to display in the data display field.

Select Graph to Show Lﬁj

JlGraph T
V| Graph 2 Carncel |

o | Graph 4

Figure 6.26 [Select Graph to Show] dialog box

[Graph 1] Displays the graph for photometric mode 1 as graph 1 in the data display
field.

[Graph 2] Displays the graph for photometric mode 2 as graph 2 in the data display
field.

[Graph 3] Displays the graph for photometric mode 3 as graph 3 in the data display
field.

[Graph 4] Displays the graph for photometric mode 4 as graph 4 in the data display
field.

<OK> Selects the graphs to display and closes the dialog box.

<Cancel> Closes the dialog box without selecting a graphs to display.

6.5.8 [Information Bar]
Shows/hides the information bar.

6.5.9 [Accessory Bar]

Shows/hides the accessory bar.

6.5.10 [Toolbars]

Shows/hides toolbars.

[File] Shows/hides the toolbar corresponding to the [File] menu.
[Measure] Shows/hides the toolbar corresponding to the [Measure] menu.
[Control] Shows/hides the toolbar corresponding to the [Control] menu.
[View] Shows/hides the toolbar corresponding to the [View] menu.

6.5.11 [Status Bar]

Shows/hides the status bar.
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6.5.12 [View Mode]

Displays the photometric value in digital or graph mode in the photometric value monitor.

=R

.
Data Menitor - J-1500/115001
Measure  Control  View Settings  Help
€% 2735 ||| 620 mees | 99 v
nm
W A% 2@) ()=
= CD{mdeg]
Infarmation
Item Contents =
-l #1500 idle
N S erial Mo J15001
Cell units R5C-A02 / 50z
= 7 Parameters
Phaotametric mode CDO.HT =
CD scale 200 mdeg/0.2
FL scale 200 mdeg/0.2
D.LT. 1 sec
Bandwidth 1.00 nm
Wavelength 2735 nm
= ﬁ.ﬂ\dministrator
E=IFull Mame Administrato
ﬂDivision -
4 1} L3
x
M ain units
Measurement units
Cell urits
Jﬁﬂg RS C-502/502001
i’z Statdard Cell Holder
Ready MUM
| %
Figure 6.27 Digital mode of the photometric value monitor
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Data Monitor - J-1500/J15001
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FL scale 200 mdeg/0.2 o0k
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Figure 6.28 Graph mode of the photometric value monitor
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6.5.13 [Graph View]

Specifies [Patterns], [Fonts], [Gridlines] and [Styles] when graph mode is selected for the
photometric value monitor. Refer to Sections 6.5.2 [Patterns...], 6.5.3 [Fonts...], 6.5.4
[Gridlines...] and 6.5.5 [Styles...] for details about setting each command.

6.6 [Settings] Menu
6.6.1 [Default Parameters...]

| Note: In the CFR version, this function is not available. |

Specifies measurement parameters for running the measurement program based on the
currently recognized accessory. Default parameters can be specified for each accessory.
Attach the accessory to be used and specify its default parameters.

r N
Default Parameters [ﬁ,l

@ Jpen the most recently uzed parameters

Open the specified parameter file

Browsze ..

[ ] 1 ] | Cancel |

Figure 6.29 [Default Parameters] dialog box

[Open the most recently used | Starts with the parameters previously specified before
parameters] exiting the measurement program.

[Open the specified parameter | Starts with a specified parameter file.
file]

[File name] Displays the name of path to the parameter file when the
[Open the specified parameter file] option button is
selected.

<Browse...> Selects the drive and file name for a saved parameter file
(see Fig. 6.30).
<OK> Applies the changes to the [Default Parameters] settings

and closes the dialog box.

<Cancel> Closes the dialog box without applying any changes to the
[Default Parameters] settings.
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[ Select Parameters ﬁ1

Look i  Data v‘ ¢« I W

Files of type: [F'arameter Files [*.cdsp) *H Cancel ]

b

Figure 6.30 [Select Parameters] dialog box (when <Browse...> is clicked in [Default
Parameters])

6.6.2 [Customize Toolbar...]

Customizes and shows/hides toolbars.

Edit Toolbar

File

Meazure ment
Cantral

View

F Dizplay

buttan text

Figure 6.31 [Edit Toolbar] dialog box

[File] Shows/hides the toolbar corresponding to the [File] menu and
adds/removes the following tool buttons.

Button Name
= [Save]
iy [Send to Analysis]
E [Open Parameters]]
ﬁ| [Save Parameters]
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[Measurement] Shows/hides the toolbar corresponding to the [Measure] menu and
adds/removes the following tool buttons.
Button Name
@ [Cancel]
o [Sample Measurement]
£ [Baseline Measurement]/
[Blank Measurement]
9 [DC Dark Measurement]
ﬂ [Parameters]
[Control] Shows/hides the toolbar corresponding to the [Control] menu and
adds/removes the following tool buttons.
Button Name
K3 [Auto Zero]
[Shutter]
nm
-« [Move Wavelength]
g [Sensitivity]
Q @5 [Light Source][Hg Lamp]
[View] Shows/hides the toolbar corresponding to the [View] menu and

adds/removes the following tool buttons.

Button Name
i [Scales]
= [Patterns]
w [Fonts]
[Gridlines]
i, [Styles]
B |[Digital]
= [Graph]

[Display button text]

Displays the button name under each tool button.

<Customize...>

Displays the dialog box for customizing toolbars (see Fig. 6.32).
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-
Customize Toolbar

Ayailable toolbar buttons:

Current toolbar buttons: Close

Separatar

- | Send to Analysis - Reset

Separator

E_‘ Open Parametars

<-R =
Zemone ﬁ‘ Sawe Parameters T
Mowve Up

- _ * | | Mowe Down

k 4 ¥

dlll

Help

Figure 6.32 [Customize Toolbar] dialog box

6.6.3 [Monitor Bar...]

Customizes the style for the monitor bar.

Monitor Bar Style

Style

(7 Clagsi @ Standard
I Clagsic @ Standar

Size
@ Mormal () Large () Extra large
Background
colar:

Figure 6.33 [Monitor Bar Style] dialog box

[Style] Selects the style for the monitor bar.
[Classic]: 999.9 pwm
md
[Standard]: 999.9 L
[Size] Selects the size for the monitor bar.

Size: [Normal], [Large], [Extra large]

[Background color]

Selects the background color for the monitor bar when [Standard]
is selected for [Style].

6.7 [Help] Menu

6.7.1 [About..]

Displays version information for each measurement program.
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7. [Spectra Measurement] Program Reference

The [Spectra Measurement] program measures the change in the sample signal intensity while
scanning the wavelength. This chapter describes specific measurement parameters for the
[Spectra Measurement] program.

7.1 [Parameters...]

Specifies measurement parameters.

The window has four tabs for parameter settings, as shown in Figs 7.2 [General], Fig. 7.3
[Control], Fig. 7.4 [Information], and Fig. 7.5 [Datal.

The [General] tab is open by default in the [Parameters] dialog box. The page can be changed
by clicking each tab at the top of the dialog box.

The parameters can be switched between two modes: Basic mode and Advanced mode. In
Basic mode, the choice of parameters is partially limited. In Advanced mode, each parameter
is specified individually.

<Basic Mode/Advanced | Switches between Basic and Advanced modes. Advanced mode

Mode> can only be used for J-1500.

<Open...> Opens a measurement parameter file.

<Save...> Saves the measurement parameters. In the CFR version, an
electronic signature is required for saving parameters.

<Default> Restores the parameters of the [General] and [Control] tabs to
their default values.

<OK> Applies the changes to the [Parameters] settings and closes the
dialog box.

<Cancel> Closes the dialog box without applying any changes to the
[Parameters] settings.

Note 1: This operation can also be performed by clicking the tool button | i
[Parameters].

Note 2: In the CFR version, Managers or Analysts authority is required to specify the
parameters.

Note 3: In the CFR version, when the parameters are specified or changed, a
signature is required. Clicking the <OK> button when the parameters have not
been saved displays the following message.

r -
Parameters I,ﬁ,l

The parameters have been modified.
! . Save the parameters before ending setup,

b 0K

b

Figure 7.1 Message when the signature for the parameters is missing
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711 [General] tab
r:I Parameters Basic @1

General | Contral | Infarmaticn | Data |

Photometric mode Stark: 300 hm

Channels Num: 2 = i 200

Charinel 1: Data pitch: 01nm -
Chaninel Start mode: Immediately

HT Scanning maode: | Continuous

II

LY singlelbs] Scanning speed: | 100 nmdmin =

CDscale  [200mdeg/1.0d0D =)

DIT.: Accumnulationcycle

Accumulation;

. Mo, of 1
Bandwidth: 1,00 nm accumnulations:
[ Advanced Mode ] [ Open... ] [ Save... ] [ Default ] [ 0k, ] [ Cancel ]

Figure 7.2(a) J-1100 [General] tab in [Parameters] dialog box

- B
7] Parameters Adwvanced ﬁ
General | Cantral | Informatinnl Data |
Photometric mode Start: 350 nm
Chamnels Num: 2 = Bt 220
End: firm

Channel 1: Data pitch: 01 nm -
Channel Z: Start mode: Immediately

External 1 Scanning mode: | Continuous

Extemnal. 2

II

Scanning speed: [ 100 nmdmin -«

CDscale  [200mdeg/1.0d0D |

FLscale  [200mdeg.0d0D  ~|

OIT.: Accumulationdcycle

Accurnulation:
Mo, of
Bandwidthe 1,00 i accumulations:
(] Shit widtk: | 100
[ Bazic Mode ][ Open... H Save.. H Default ][ ] J[ Cancel ]

Figure 7.2(b) J-1500 [General] tab in [Parameters] dialog box
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General |I:Dntn:||| Infnlmatinnl Data |

Photometric mode

ry

Channels Mur: 2

Start: 350 -
End: &00 nm
Data pitche 100nm -
Start mode: Immediately

LD Scanning speed: | 500 nmdmin *
CD scale: [2IZII:I mdeg.1.0 dOD VI
FL scale: [2IZII:I mdeg.1.0 dOD VI
D.LT.: NIR DT :
Bandwidtc 1.0 - NIF: bandwidt:
[ 5lit widthe | 100 [TINIR slit width: 100
Accumulationdcycle
Accumulation;
Mo, of
accunmulations:
[ B azic Mode H Open... Jl Sawe.. H Diefault H QK H Cancel J

Figure 7.2(c) J-1700 [General] tab in [Parameters] dialog box

Photometric mode

mode.

Selects the desired measurement parameters for the photometric

[Channels Num]

Options: 1 to 4

Selects the number of channels to display in the spectrum display
field. Click the arrow (¥ or A) to select the number of channels.

[Channel n] Selects the photometric mode for each channel. Click the drop-down
list to select the photometric mode.
[CD scale] Selects the CD/LD range for the detector in the transmission

configuration.

[20 mdeg/0.05 dOD]:

[200 mdeg/1.0 dOD]:

[2000 mdeg/1.0 dOD]:

[10000 mdeg/1.0 dOD]:

High sensitivity mode. Available when the
CD range is within £20 mdeg and the LD
range is within £0.05 dOD.

Standard sensitivity mode. Available when
the CD range is within £200 mdeg and the
LD range is within £1.0 dOD.

Wide range mode. Available when the CD
range is within £2000 mdeg and the LD
range is within £1.0 dOD.

Maximum range mode. Available when
the CD range is within £10000 mdeg and
the LD range is within £1.0 dOD.
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[FL scale]

Selects the FDCD/FDLD range for the C detector in the fluorescence

configuration.

[20 mdeg/0.05 dOD]:

[200 mdeg/1.0 dOD]:

[2000 mdeg/1.0 dOD]:

[10000 mdeg/1.0 dOD]:

High sensitivity mode. Available when the
FDCD range is within £20 mdeg and the
FDLD range is within £0.05 dOD.
Standard sensitivity mode. Available when
the FDCD range is within £200 mdeg and
the FDLD range is within £1.0 dOD.

Wide range mode. Available when the
FDCD range is within £2000 mdeg and the
FDLD range is within £1.0 dOD.
Maximum range mode. Available when
the FDCD range is within £10000 mdeg
and the FDLD range is within £1.0 dOD.

[D.I.T.]

Selects the data acquisition time (integration time) per point.
J-1100: 5 msec to 8 sec
J-1500/1700: 0.1 msec to 30 sec

[Bandwidth]

Selects the spectral bandwidth.

J-1100: 1 nm (fixed)

J-1500/1700: 0.01 nm to 16.00 nm

[Slit width]

Specifies the slit width within the range from 1 to 4000 um. Selecting
[Slit width] activates the text box for entering the slit width.

[Start]

Specifies the measurement start wavelength.
J-1100: 180 to 600 nm

J-1500: 163 to 1600 nm
J-1700: 163 to 2500 nm

[End]

Specifies the measurement end wavelength.
J-1100: 180 to 600 nm

J-1500: 163 to 1600 nm
J-1700: 163 to 2500 nm

[Data pitch]

Selects the wavelength interval for data acquisition.

[Start mode]

Selects the measurement start condition.

Options: [Immediately], [Wait for ext trigger]

Use [Wait for ext. trigger] when an optional accessory such as a
stopped flow system is used.

[Scanning mode]

Selects the scanning mode.

Options:
[Continuous]:

[Step]:

Continuous scan. Scans the wavelength
at the speed specified in [Scanning
speed].

Step scan. Increments the wavelength in
steps corresponding to the data
wavelength interval, and performs
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measurements at each wavelength for a
time specified by [D.I.T.] while the drive is
stopped. The scanning speed depends on
[D.I.T.]. In this case, the D.L.T. value is
chosen automatically and cannot be
selected.

[Step (Auto)]: Performs a step scan while automatically
adjusting D.LT. to obtain a constant
signal-to-noise ratio. Selecting [Step
(Auto)] displays [D.I.T. Upper] and [D.I.T.
Lower] instead of [D.I.T.]. Click the arrows
to display the drop-down lists and select
the desired values. In the Ilow
signal-to-noise ratio region, the D.I.T. is
automatically set between [D.I.T. Upper]
and [D.I.T. Lower].

[Scanning speed]

Specifies the scanning speed. Available if [Continuous] is selected for
[Scanning mode].

J-1100: 1 nm/min to 5000 nm/min

J-1500/1700: 1 nm/min to 10000 nm

[NIRD. 1. T]

Selects the data acquisition time (integration time) per point for NIR
region.
J-1700: 016 msec to 30 sec

[NIR bandwidth]

Selects the spectral bandwidth for NIR region.
J-1700: 20 nm, 30 nm, 40 nm, 50 nm

[NIR slit width]

Specifies the slit width within the range from 1 to 4000 um. Selecting
[NIR slit width] activates the text box for entering the slit width. (only
for J-1700)

Accumulation/cycle

[No. of cycles]

Specifies the number of measurements for each sample. When 2 or
more measurements are specified, the [Cycle interval] text box is
displayed.

Input range: 1 to 999

Note: When the [Accumulation] check box is selected, [No. of
cycles] is not displayed.

[Accumulation]

Specifies that cumulative averaging should be used to measure the
spectrum. Selecting [Accumulation] displays [No. of accumulations].

[No. of
accumulations]

Specifies the number of measurements used to average the spectrum.
If measurement is stopped, all completed accumulations are
averaged.

111



71.2 [Control] tab

-

Carrection

(71 Mone

General | Control |Infu:urmati-:un I [ ata |

Shutter ig opened and clozed automatically

Shutter is clozed between meazurements.

B azic Mode

] [ Open... ] [ Save.. ] [ Drefault ] [

OE.

] [ Cancel ]

Figure 7.3 [Control] tab in [Parameters] dialog box

Correction
[None] Selects the use of no correction.
[Baseline] Selects baseline correction using a measured baseline.

[Shutter is opened and

closed automatically]

between measurements.

Automatically opens the shutter just before the measurement
starts and closes it after the measurement finishes, regardless
of the current shutter status. Even when this option is selected,
if cycle measurement is selected, the shutter is not closed

[Shutter is closed

between measurements] | cycle measurement is selected.

Automatically closes the shutter between measurements, if
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71.3 [Information] tab

i -
77 Parameters Advancad [ﬁ
iematon Dot

Sample name;

Dperator:

Drivizion;

Comment;

Concentration:
Saolvent:

[] Digplay the [Comments] dialog box before measurement

B azic Mode ][ Opeh... H Save.. H Default ][ k. ][ Cancel ]

Figure 7.4 [Information] tab in [Parameters] dialog box

[Sample name] Enters a sample name (maximum 63 characters).

[Operator] Enters an operator name (maximum 63 characters).

[Division] Enters a division name for the operator (maximum 127
characters).

[Comment] Enters a comment (maximum 127 characters).

[Concentration] Enters a sample concentration. There is no character
limit.

[Solvent] Enters a solvent name (maximum 127 single-byte
characters).

[Display the [Comments] Displays the [Comments] dialog box for each

dialog box before measurement.

measurement]

Note: In the CFR version, the [Operator] and [Division] text boxes cannot be
changed by the user.
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71.4 [Data] tab

-

77 Parameters Advancad ﬁw
| General | Control I Infl:urmatil:un| Data |
Browse. .
Drate-Mo.
[] Ta Spectra Analysis
[] Prirt data after measurement
Browse. ..
H Open... H Save. . H Diefault ][ aF. ][ Cancel ]

Figure 7.5 [Data] tab in [Parameters] dialog box

Save data

Selects to automatically save data. A file name is automatically
allocated to the measured data and the data is saved to the
specified directory.

Note: In the CFR version, when [Auto save] is selected,
the following dialog box is displayed when the
sample measurement starts. Start the
measurement after typing a signature.

-

Creation Signature [Auto Save) I&

% Uszemame:  Admimiztrator

Pazsword:

[ Sign ] [ Cancel ]

Figure 7.6 [Creation Signature (Auto Save)] dialog box

[Auto save]

Automatically saves measured data.

[Save in]

Displays the drive and folder name for saving data.
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<Browse...>

Browses to the [Save in] drive and folder.

[Format] Selects the file name to be assigned during auto saving. The file
format is Standard Files (*.jws).

[Date-No.] Sets [Date] + [3-digit serial number] as the file name. The date
and serial number are connected with a hyphen “-”.

[Sample-No.] Sets [Sample name] + [3-digit serial number] as the file name.

[Sample name] is the name entered in the [Information] tab.

[Comment-No.]

Sets [Comment] + [3 digit serial number] as the file name.
[Comment] is the comment entered in the [Information] tab.

[Sample-Comment-No.]

Sets [Sample name] + [Comment] + [3-digit serial number] as the
file name. [Sample name] and [Comment] are the name and
comment entered in the [Information] tab, respectively.

[String-No.]

Sets [String-No.] + [3-digit serial number] as the file name. Type
the character string in the text box below the drop-down list
(maximum 63 single-byte characters).

[String]

Enters a character string when [String-No.] is selected for
[Format] (maximum 63 single-byte characters).

Send data

Selects to automatically send measured data to the [Spectra
Analysis] program after measurement.

[To Spectra Analysis]

Automatically sends measured data to the [Spectra Analysis]
program after measurement.

Print Selects to automatically print data after measurement.
[Print data after | Automatically prints data after measurement.
measurement]

[Template] Displays the drive and file name of a saved template file.
<Browse...> Selects the drive and file name of a saved template file.
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8. [Time Course Measurement] Program Reference

The [Time Course Measurement] program measures the temporal change in the sample signal
intensity at a fixed wavelength. This chapter describes specific measurement parameters for
the [Time Course Measurement] program.

8.1 [Parameters...]

Specifies the measurement parameters.

The window has four tabs for parameter settings, as shown in Figs 8.2 [General], Fig. 8.3
[Control], Fig. 8.4 [Information], and Fig. 8.5 [Data]. The [General] tab is open by default in the
[Parameters] dialog box. The page can be changed by clicking each tab at the top of the dialog
box.

The parameters can be switched between two modes: Basic mode and Advanced mode. In
Basic mode, the choice of parameters is partially limited. In Advanced mode, each parameter
is specified individually.

<Basic Mode/Advanced | Switches between Basic and Advanced modes. Advanced mode

Mode> can only be used for J-1500.

<Open...> Opens a measurement parameter file.

<Save...> Saves the measurement parameters. In the CFR version, an
electronic signature is required for saving parameters.

<Default> Restores the parameters of the [General] and [Control] tabs to their
default values.

<OK> Applies the changes to the [Parameters] settings and closes the
dialog box.

<Cancel> Closes the dialog box without applying any changes to the
[Parameters] settings.

Note 1: This operation can also be performed by clicking the tool button | i

[Parameters].

Note 2: In the CFR version, Managers or Analysts authority is required to specify the
parameters.

Note 3: In the CFR version, when the parameters are specified or changed, a
signature is required. Clicking the <OK> button when the parameters have not
been saved displays the following message.

.
Parameters I,&J

The parameters have been modified.
! . Save the parameters before ending setup,

A

Figure 8.1 Message when the signature for the parameters is missing

116




8.1.1 [General] tab

7] Parametars Advanced @

General | Contral | Informmation | Data |

Photometnc mode ‘wavelength: 2537 nm

.2 = L
Charnnels Num: = Weeat s BN

Charnel 1: Drata pitch:
Channel 2 Start mode: [Immedialel_'r' "]

Ch

Ch

CD scale: 200 mdeg/1.0d0D  + |

Accumulation/cycle
Accumulation:
. Mo, of 1
Bandwidth: | 1.00 nnm accumulations:
[T St widtk: | 100
[ Bazic Mode l [ Open... ] l Save.. ][ Default ” 0K ][ Cancel ]

Figure 8.2(a) J-1100 [General] tab in [Parameters] dialog box

FF] Parameters Adwvanced M

General | Cantral | Infarmation I Data |

Photometric mode Wavelength; 2735 hrm

- o
Ehannels Nun: = Measzuring time: B0

Channel 1: | D'ata pitch:

Euternal 1

Extemnal 2

CD zcale: [2EIEI mdegd1.0 0D ']
FLscale:  [200mdeg/1.0d0D  w| Accumulation/cycle

Acoumulation:

Mo, of 1
Bandwidth: ~ 1.00 nm accuriulations:
[T 51t width: | 100
[ Bazic Mode ][ Open... H Save... ][ Default ][ QK ][ Cancel ]

Figure 8.2(b) J-1500 [General] tab in [Parameters] dialog box
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7] Parameters Advanced ﬁ
General |I:Dntn:||| Information I Data |
Phaotometric mode wavelength: 2537 hm
Lo =
Charirels Nur: = Measuring time;  BO
Channel 1: | Data pitch:
Charnel 2 Stat mod
(]
Ch
CD zcale: [2!]0 mdeg/1.0 dOD VJ
FL zcale: [2DD mdeg/1.0 400 vJ
DLT.: NIRD.LT.:
Bardwidth, 1.0 - NIR bandwidth:
[T St width; | 100 [CTMIR slit width: 100
Accumulation/cycle
Accumulation:
Ma. af 1
accumulations:
I Basic Mode I [ Open... I I Save. . J [ Default I [ 0k ] I Cancel I

Figure 8.2(c) J-1700 [General] tab in [Parameters] dialog box

Photometric mode

mode.

Selects the desired measurement parameters for the photometric

[Channels Num]

Options: 1to 4

Click the arrow (¥ or A) and select [Channels Num:] to display in the
time-course data display field.

[Channel n] Selects the photometric mode for each channel. Click the drop-down
list to select the photometric mode.
[CD scale] Selects the CD/LD scale range for the detector in the transmission

configuration.

[20 mdeg/0.05 dOD]:

[200 mdeg/1.0 dOD]:

[2000 mdeg/1.0 dOD]:

[10000 mdeg/1.0 dOD]:

High sensitivity mode. Available when the
CD range is within £20 mdeg and the LD
range is within £0.05 dOD.

Standard sensitivity mode. Available when
the CD range is within £200 mdeg and the
LD range is within £1.0 dOD.

Wide range mode. Available when the CD
range is within +£2000 mdeg and the LD
range is within £1.0 dOD.

Maximum range mode. Available when
the CD range is within £10000 mdeg and
the LD range is within £1.0 dOD.
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[FL scale]

Selects the FDCD/FDLD scale range for the C detector in the
fluorescence configuration.

[20 mdeg/0.05 dOD]:  High sensitivity mode. Available when the
FDCD range is within £10 mdeg and the
FDLD range is within £0.05 dOD.

[200 mdeg/1.0 dOD]:  Standard sensitivity mode. Available when
the FDCD range is within £200 mdeg and
the FDLD range is within £1.0 dOD.

[2000 mdeg/1.0 dOD]: Wide range mode. Available when the
FDCD range is within £2000 mdeg and the
FDLD range is within £1.0 dOD.

[10000 mdeg/1.0 dOD]: Maximum range mode. Available when
the FDCD range is within £10000 mdeg
and the FDLD range is within +1.0 dOD.

[D.I.T.]

Selects the data acquisition time (integration time) per point.
J-1100: 5 msec to 8 sec
J-1500/1700: 0.1 msec to 30 sec

[Bandwidth]

Selects the spectral bandwidth.
J-1100: 1 nm (fixed)
J-1500/1700: 0.01 nm to 16.00 nm

[Slit width]

Specifies the slit width within the range from 1 to 4000 um. Selecting
[Slit width] activates the text box for entering the slit width.

[Wavelength]

Specifies the measurement start wavelength.
J-1100: 180 to 600 nm

J-1500: 163 to 1600 nm

J-1700: 163 to 2500 nm

[Measuring time]

Specifies the measurement time.
Input range: 2 1012002 sec

[Data pitch]

Selects the wavelength interval for data acquisition.

[Start mode] Selects the measurement start condition.
Options: [Immediately], [Wait for ext trigger]
Use [Wait for ext. trigger] when an optional accessory such as a
stopped flow system is used.

[NIRD.I.T.] Selects the data acquisition time (integration time) per point for NIR

region.
J-1700: 016 msec to 30 sec

[NIR bandwidth]

Selects the spectral bandwidth for NIR region.
J-1700: 20 nm, 30 nm, 40 nm, 50 nm

[NIR slit width]

Specifies the slit width within the range from 1 to 4000 um. Selecting
[Slit width] activates the text box for entering the slit width. (only for
J-1700)

Accumulation/cycle

[No. of cycles]

Specifies the number of measurements for each sample. When 2 or
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more measurements are specified, the [Cycle interval] text box is
displayed.
Input range: 1 to 999

Note: When the [Accumulation] check box is selected, [No. of
cycles] is not displayed.

[Accumulation]

Specifies that cumulative averaging should be used to measure the
spectrum. Selecting [Accumulation] displays [No. of accumulations].

[No. of
accumulations]

Specifies the number of measurements used to average the spectrum.
If measurement is stopped, all completed accumulations are
averaged.

Input range: 1 to 999.
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8.1.2 [Control] tab

r© N
77| Parameters Advancad Iﬁ
Gieneral | Control |Inf|:|rmati-:|n I Data |
Correction
@ Hone ) Blank

[] Shutter is opened and closed automatically

B azic Mode H Open... ][ Save.. ][ Drefault ][ k. ][ Cancel ]

Figure 8.3 [Control] tab in [Parameters] dialog box

Correction

[None] Selects the use of no correction.

[Blank] Selects blank correction using a measured blank.
[Shutter is opened and Automatically opens the shutter just before the measurement
closed automatically] starts and closes it after the measurement finishes, regardless

of the current shutter status. Even when this option is selected,
if cycle measurement is selected, the shutter is not closed
between measurements.
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8.1.3 [Information] tab

i -
77 Parameters Advanced [ﬁ
iematon Dot

Sample name; |

Adrniniztrator

Comment;

Concentration:

Salvent:

[ Digplay the [Comments] dialog box before measurement

B azic Mode ][ Opeh... H Save.. H Default ][ k. ][ Cancel ]

Figure 8.4 [Information] tab in [Parameters] dialog box

[Sample name] Enters a sample name (maximum 63 characters).

[Operator] Enters an operator name (maximum 63 characters).

[Division] Enters a division name for the operator (maximum 127
characters).

[Comment] Enters a comment (maximum 127 characters).

[Concentration] Enters a sample concentration. There is no character
limit.

[Solvent] Enters a solvent name (maximum 127 single-byte
characters).

[Display the [Comments] Displays the [Comments] dialog box for each

dialog box before measurement.

measurement]

Note: In the CFR version, the [Operator] and [Division] text boxes cannot be
changed by the user.
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8.14

-

[Data] tab

| Gerneral | Cortrol I Infl:urmati-:un| Data |

[7] Ta Specta Analysis

[] Print data after measurement

Browse...

[rate-Mo.

Browse. .

H Open... ][ Save.. ][ Drefault ][ ()4 ][ Cancel ]

Figure 8.5 [Data] tab in [Parameters] dialog box

Save data

Selects to automatically save data. A file name is automatically

allocated to the measured data and the data is saved to the
specified directory.

Note: In the CFR version, when [Auto save] is selected,
the following dialog box is displayed when the
sample measurement starts. Start the
measurement after typing a signature.

-

Creation Signature [Auto Save) I&
% Username;  Administrator
Pazsword:
[ Sign ] [ Cancel ]

Figure 8.6 [Creation Signature (Auto Save)] dialog box

[Auto save]

Automatically saves measured data

[Save in]

Displays the drive and folder name for saving data.
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<Browse...>

Browses to the [Save in] drive and folder.

[Format] Selects the file name to be assigned during auto saving. The file
format is Standard Files (*.jws).
[Date-No.] Sets [Date] + [3-digit serial number] as the file name. The date
and serial number are connected with a hyphen “-”.
[Sample-No.] Sets [Sample name] + [3-digit serial number] as the file name.

[Sample name] is the name entered in the [Information] tab.

[Comment-No.]

Sets [Comment] + [3 digit serial number] as the file name.
[Comment] is the comment entered in the [Information] tab.

[Sample-Comment-No.]

Sets [Sample name] + [Comment] + [3-digit serial number] as the
file name. [Sample name] and [Comment] are the name and
comment entered in the [Information] tab, respectively.

[String-No.]

Sets [String-No.] + [3-digit serial number] as the file name. Type
the character string in the text box below the drop-down list
(maximum 63 single-byte characters).

[String]

Enters a character string when [String-No.] is selected for
[Format] (maximum 63 single-byte characters).

Send data

Selects to automatically send measured data to [Spectra
Analysis] program after measurement.

[To Spectra Analysis]

Automatically sends measured data to the [Spectra Analysis]
program after measurement.

Print Selects to automatically print data after measurement.
[Print data after Automatically prints data after measurement.
measurement]

[Template] Displays the drive and file name of a saved template file.
<Browse...> Selects the drive and file name of a saved template file.
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9. [Data Monitor] program reference
The [Data Monitor] program is used to provide an enlarged display of the photometric values
when the CD spectrometer is being tested or calibrated. This chapter describes specific

measurement parameters for the [Data Monitor] program.

=R

.
Data Monitor - J-1500/115001
Measure  Control  View Settings  Help
€% 2735 ||| 620 mees | 99 v
nm
i | x4 T ®
x
Infarmation
Item Contents =
-l #1500 idle
N S erial Mo J15001
Cell units R5C-A02 / 50z
= 7 Parameters
Phaotametric mode CDO.HT =
CD scale 200 mdeg/0.2
FL scale 200 mdeg/0.2
D.LT. 1 sec
Bandwidth 1.00 nm
Wavelength 2735 nm
= ﬁ.ﬂ\dministrator
E=IFull Mame Administrato
ﬂDivision -
4 1} L3
x
M ain units
Measurement units
Cell urits
ﬂb RS C-502/502001
i’z Statdard Cell Holder
Ready MUM
| %

Figure 9.1 [Data Monitor] digital-mode display
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Data Monitor - J-1500/115001 NN X
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Figure 9.2 [Data Monitor] graph-mode display

9.1 [Parameters...]

Specifies the measurement parameters.

<OK> Applies the changes to the [Parameters] settings and closes the dialog box.
<Cancel> Closes the dialog box without applying any changes to the [Parameters]
settings.

Note: This operation can also be performed by clicking the tool button ﬂ
[Parameters].
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9.1.1

[Parameters]

Parameters Iﬁ

Photometric mode

Channels Mum, 2 = “Wavelength: 2837 nm

Channel 1: tonitoring time: B0 B0

Ch

Ch

CDscals 200 mdea/1.0d0D  ~

DT :

Bandwidth: | 1.00 hm
[T St width: | 100

£ Ok, i [ Cancel ]

Figure 9.3(a) J-1100 [General] tab in [Parameters] dialog box

Parameters

Photometric mode

= W avelength: 2537 i

Channel 1: tonitoring time: B0 B0

Channels Hum; 2

Ch
Ch

CDscale  [200mdea/1.0d0D  ~|

FLscale  [200mdeg/1.0d0D  ~|

DT :

Bandwidth:  1.00 hm
[T St width: | 100

| Ok, d [ Cancel ]

Figure 9.3(b) J-1500 [General] tab in [Parameters] dialog box
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Parameters

Photometric mode

Channels Mum, 2 = “Wavelength: 2837 nm

Channel 1: |CD - tonitoring time: B0 B0

Chanrel 22 |HT -

Ch
Ch

CDscale:  [200mdeg/1.0d0D  ~|

FLscale  [200mdeg/1.0d0D  ~|

OILT.: 1 zec - MIR DT, : 1 zec -
(20m -]

Bandwidth:  1.00 hm MIR bandwidth: 20nm -
Shit width: | 100 MIR slit width: 100
[ Ok l | Cancel |

Figure 9.3(c) J-1700 [General] tab in [Parameters] dialog box

Photometric mode

mode.

Selects the desired measurement parameters for the photometric

[Channels Num]

Options: 1to 4

Click the arrow (¥ or A) and select [Channels Num:] to display in the
time-course data display field.

[Channel n]

Selects the photometric mode for each channel. Click the drop-down
list to select the photometric mode.

[CD scale]

configuration.
[20 mdeg/0.05 dOD]:

[200 mdeg/1.0 dOD]:

[2000 mdeg/1.0 dOD]:

[10000 mdeg/1.0 dOD]:

Selects the CD/LD scale range for the detector in the transmission

High sensitivity mode. Available when
the CD range is within £20 mdeg and the
LD range is within £0.05 dOD.

Standard sensitivity mode. Available
when the CD range is within £200 mdeg
and the LD range is within £1.0 dOD.
Wide range mode. Available when the
CD range is within £2000 mdeg and the
LD range is within £1.0 dOD.

Maximum range mode. Available when
the CD range is within 10000 mdeg and
the LD range is within £1.0 dOD.

[FL scale]

Selects the FDCD/FDLD
fluorescence configuration.
[20 mdeg/0.05 dOD]:

scale range for the C detector in the

High sensitivity mode. Available when
the FDCD range is within £20 mdeg and
the FDLD range is within £0.05 dOD.
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[200 mdeg/1.0 dOD]: Standard sensitivity mode. Available
when the FDCD range is within 200
mdeg and the FDLD range is within +1.0
dOD.

[2000 mdeg/1.0 dOD]: Wide range mode. Available when the
FDCD range is within £2000 mdeg and
the FDLD range is within £1.0 dOD.

[10000 mdeg/1.0 dOD]:Maximum range mode. Available when

the FDCD range is within £10000 mdeg
and the FDLD range is within £1.0 dOD.

[D.I.T.]

Selects the data acquisition time (integration time) per point.
J-1100: 5 msec to 8 sec
J-1500/1700: 0.1 msec to 30 sec

[Bandwidth]

Selects the spectral bandwidth.
J-1100: 1 nm (fixed)
J-1500/1700: 0.01 nm to 16.00 nm

[Slit width]

Specifies the slit width within the range from 1 to 4000 um. Selecting
[Slit width] activates the text box for entering the slit width.

[Wavelength]

Specifies the measurement start wavelength.
J-1100: 180 to 600 nm

J-1500: 163 to 1600 nm

J-1700: 163 to 2500 nm

[Monitoring time]

Specifies the monitoring time when graph mode is selected.
Input range: 10 to 30000 sec

INIRD. 1. T.]

Selects the data acquisition time (integration time) per point for NIR
region.
J-1700: 016 msec to 30 sec

[NIR bandwidth]

Selects the spectral bandwidth for NIR region.
J-1700: 20 nm, 30 nm, 40 nm, 50 nm

[NIR slit width]

Specifies the slit width within the range from 1 to 4000 um. Selecting [Slit
width] activates the text box for entering the slit width. (Only J-1700)
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10. Appendix
10.1 Setting the Measurement Parameters

The parameters selected can seriously affect measurement results. The following summarizes
how to select parameters.

10.1.1 Measurement Wavelength Range

Most CD spectrum peaks appear in a specific wavelength region (short wavelength region as
in the case of ultraviolet-visible absorption spectra for most organic compounds). If the
optically active absorption band position for the sample is known, take measurements
beginning at a wavelength of 50 to 100 nm before the leading edge of the spectrum and ending
at the trailing edge of the spectrum where it converges at zero, although this method varies
slightly depending on the width and shape of the spectrum.

10.1.2 Data Acquisition Interval (Resolution)

10.1.2.1 Spectra measurement

Usually, a value of about 0.2 nm is sufficient. However, if the scanning mode is set to [Step],
approximately 1 nm is more appropriate. Make the resolution coarse if the spectrum peaks are
broad and fine if they are sharp.

10.1.2.2 Time-course measurement
Make the resolution fine if rapid changes with time are expected.

10.1.3 Scanning Speed

The scanning speed depends on the D. I. T. Under normal conditions, set the scanning speed
at 20 to 100 nm/min and D. I. T. at 0.25 to 2 sec. Table 8.1 shows suggested D.I.T. values for
different scanning speeds.

Table 10.1 D.L.T. values for different scanning speeds

Scanning speed (nm/min) D.I.T. (recommended) Upper limit
10000 1.0to 2.0 msec 32.0 msec
5000 2.0to0 4.0 msec 64.0 msec
2000 4.0 to 8.0 msec 0.25 sec
1000 32.0 msec to 0.125 sec 0.5 sec

500 64.0 msec to 0.25 sec 1.0 sec
200 0.125t0 0.5 sec 2.0 sec
100 0.25t0 1.0 sec 4.0 sec
50 0.5t0 2.0 sec 8.0 sec
20 1.0t0 2.0 sec 16.0 sec
10 2.0t04.0 sec 16.0 sec
5 2.0t0 8.0 sec 16.0 sec
2 4.0to 16.0 sec 16.0 sec
1 8.0t0 16.0 sec 16.0 sec
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10.1.4 Number of Accumulations

The following relationship exists between the signal-to-noise ratio and the number of
accumulations: S/N o \(Number of accumulations).

Increasing the number of accumulations improves the signal-to-noise ratio for a spectrum.
Determine the appropriate number of accumulations based on the spectrum (sample)
condition and the overall measurement time (increasing the number of accumulations prolongs
the measurement time).

If the sensitivity is lower than Standard, a single accumulation will suffice. Table 10.2 shows
the suggested number of accumulations when a sample with an absorbance of 1 or less is
measured with a D.I.T. of 2 sec.

Table 10.2 No. of accumulations and sensitivity (D.I.T. 2 sec)

Sensitivity Number of accumulations
High 4 to 50
Standard, Low 1

Note: For time-course measurements, set the number of accumulations to 1.
Cumulative measurement can be used in stopped flow measurement (see the
instruction manual for the stopped flow unit).

10.1.5 Response (D.I.T.)
10.1.5.1 Spectra measurement

The following relationship exists between D.I.T. and the signal-to-noise ratio:

SIN « +/(Response).

The signal-to-noise ratio for a spectrum measured for 4 seconds is twice that for a spectrum
measured for 1 second.

The spectral value at any given point in time is the average of values sampled before and after
that time (D.1.T./2). Therefore, increasing D.|.T. leads to a greater effect of previous data on the
current data. Do not increase D.I.T. excessively if scanning is carried out at high speed or if the
resolution is low.

Table 10.3 shows suggested D.I.T. values for obtaining a spectrum with a high signal-to-noise
ratio at a desired sensitivity. If the sensitivity is set at 10 mdegand D.|. T. is setat 1 to 2 secto
improve the signal-to-noise ratio, increasing the number of accumulations is very effective
because the spectrum is simultaneously averaged.

Table 10.3 D.1.T. values for obtaining high signal-to-noise ratio

CD scale (mdeg) D.LT. (sec)
10 0.5t0 16.0
200 0.125t0 0.5

2000 0.025 to 0.064

Note: A D.I.T. of 0.5 to 125 msec should be selected for high speed measurement
using a stopped flow unit.
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The above table also applies to a step scan. In this case, the measurement time is the sum of
the wavelength stepping time and the data acquisition time at each step. If the D.I.T. is on the
order of seconds, the number of accumulations will dominate the measurement time and the
measurement time will be almost proportional to D.I.T. For a total wavelength measurement
range of W (nm) and a data interval of Step (nm), the following relation holds between the total
integration time and D.I.T.

Total Integration Time = (W/Step + 1) X D.L.T.

(W/Step + 1): Number of data points

10.1.5.2 Time-course measurement

For time-course measurement, selecta D.I.T. that is appropriate given the decay half-life of the
CD signal due to a reaction. For normal reactions, set it to 1/10 of the decay half-life of the CD
signal or smaller. For example, if the decay half-life is 20 msec, a D.I.T. of 0.5 to 2 msec is
appropriate. If the decay is very slow, selecta D.I.T. of 1 to 16 sec, taking into account the rate
of change of the signal and the signal-to-noise ratio. When used as a monitor for HPLC, a D.I.T.
of about 1 sec is suitable.

10.1.6 Bandwidth and slit width

In most cases, set the measurement bandwidth to 1.0 nm. Decrease it when measuring a
sharp spectrum such as a MCD (magnetic circular dichroism) spectrum, or increase when
performing measurements using a micro cell, when the signal-to-noise ratio is low. When a
longer wavelength detector (400 to 1100 nm) is used, increase the bandwidth and set the slit
width to about 60 um to prevent the photomultiplier voltage (HT) from rising abnormally.
However, ensure that the HT voltage does not become lower than 170 V.

Note 1: If the slit width is increased until the HT voltage drops below 170 V, the
photomultiplier may be damaged.

Note 2: Most organic substances emit fluorescence. Therefore, measuring a sample
having an absorbance of 2 or more at a bandwidth of 2 nm or more may distort
the spectrum. Also, photolysis of a sample can occur in the ultraviolet region. If
the sample is susceptible to photolysis, reduce the bandwidth to 0.5 nm or
less.
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